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Preface

This guide contains the information about installing Kofax AP Agility. This guide is intended for solution
integrators who need a description of the installation and integration procedures.

This guide is written with the assumption that you have a thorough understanding of Kofax TotalAgility.

Related documentation
In addition to this guide, see the following documentation for additional installation and configuration
information.

Kofax AP Agility Release Notes
This guide contains late-breaking product information that may not be included in other Kofax AP Agility
documentation. Release notes are also available for each of your installed Kofax applications. Locate
release notes on the Kofax Support site at www.kofax.com/support.

Help for Kofax AP Agility Settings
This help provides detailed information on how to configure Kofax AP Agility for your environment.

Help for Kofax AP Agility Line Pairing Correction
This help provides use cases and examples for correcting a document that fails line pairing.

Help for Kofax AP Agility PIX Correction
This help provides detailed information about how to navigate through PIX Correction. It also includes
details about how to use PIX Correction when processing documents with Kofax AP Agility.

Help for Kofax AP Agility Validation
This help provides information about validating a document in Kofax AP Agility.
Additional documentation about validating documents is available in the Help for Kofax TotalAgility
Validation.

Help for Kofax AP Agility Scan
This help provides information on how to scan documents into Kofax AP Agility.

Help for Kofax AP Agility Workflow
This help provides information about how to use the various activities that are part of the AP Agility
workflow. This includes general information that is relevant for all activities as well as specific information
related to the Approval, Coding, Exception, Line Pairing Exception, Hold, and Comment Request
activities.
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Training
Kofax offers both classroom and computer-based training that will help you make the most of your Kofax
TotalAgility solution. Visit the Kofax website at www.kofax.com for complete details about the available
training options and schedules.

Getting help for Kofax products
Kofax regularly updates the Kofax Support site with the latest information about Kofax products.

To access some resources, you must have a valid Support Agreement with an authorized Kofax Reseller/
Partner or with Kofax directly.

Use the tools that Kofax provides for researching and identifying issues. For example, use the Kofax
Support site to search for answers about messages, keywords, and product issues. To access the Kofax
Support page, go to www.kofax.com/support.

The Kofax Support page provides:
• Product information and release news

Click a product family, select a product, and select a version number.
• Downloadable product documentation

Click a product family, select a product, and click Documentation.
• Access to product knowledge bases

Click Knowledge Base.
• Access to the Kofax Customer Portal (for eligible customers)

Click Account Management and log on.
To optimize your use of the portal, go to the Kofax Customer Portal login page and click the link to
open the Guide to the Kofax Support Portal. This guide describes how to access the support site, what
to do before contacting the support team, how to open a new case or view an open case, and what
information to collect before opening a case.

• Access to support tools
Click Tools and select the tool to use.

• Information about the support commitment for Kofax products
Click Support Details and select Kofax Support Commitment.

Use these tools to find answers to questions that you have, to learn about new functionality, and to
research possible solutions to current issues.
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Chapter 1

System requirements

Refer to the technical specifications for third-party software platform components for this product.
This document is available on www.kofax.com and it lists the versions of third-party software platform
components that are supported for use with Kofax products. Kofax is committed to ensuring that our
products work with these component versions and addressing issues that arise when our products are
used in conjunction with them. Unless otherwise specified, we do not support the use of our product in
conjunction with versions of software other than those listed in the technical specifications.

Software prerequisites
The software prerequisites required prior to the installation of Kofax AP Agility are listed as follows.

Kofax TotalAgility
Refer to the Kofax AP Agility Technical Specifications for the Kofax TotalAgility version that must be
installed on the system before installing Kofax AP Agility 2.2.0.

.NET 4.7 or higher
This is the minimum version required by the Kofax AP Agility assemblies and the Kofax TotalAgility
integration.

Internet Information Services (IIS) 7.5
This is required to install the Agnostic ERP connector.

SAP Client Component
If SAP support is required, download the "SAP .Net Connector x64 3.0.13.1" or newer from SAP. Also,
install the assemblies to GAC. (This is offered as an option during the installation.)

Oracle Client Component
If Oracle database access is required, install the Oracle Data Provider for .NET 2 (ODP.NET20) that you
can get from the Oracle website.

Localize Kofax AP Agility
The localization of Kofax AP Agility is available for the following languages.
• English
• French
• German
• Spanish
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• Brazilian Portuguese

If the main language of your web browser is set to one of the above languages, the user interface and
documentation for Kofax AP Agility appear in that language automatically. For any other language, and for
the administrative documentation, the user interface and documentation defaults to English.

However, this localizes the Kofax AP Agility activities only. Because Kofax AP Agility is a part of Kofax
TotalAgility, it is necessary to install the Kofax TotalAgility language packs to ensure a fully localized
environment. For more information about localizing Kofax TotalAgility, refer to the Kofax TotalAgility
Installation Guide.

Important installation notes
The following notes are important when installing Kofax AP Agility.

Licensing
Kofax AP Agility requires an Invoice Processing license in order to configure and process invoices.
Additionally, a license is required to process documents through the AP Agility Workflow.
Add the necessary license in Kofax TotalAgility.

Administrator Rights
To install the product, the logged on user must have Administrator rights on the local computer.

Database Editing
Kofax AP Agility does not support direct database editing. You can make any changes needed for your
solution using the Kofax AP Agility configuration tools.

Kofax AP Agility in an Azure environment
You can deploy Kofax AP Agility into an Azure hosted Kofax TotalAgility environment. However, there are
some limitations using this method of deployment over a traditional installation.
• User exits are not supported.
• SAP, Oracle, and MarkView integrations are not supported.
• PIX is not supported. Because of this you cannot process electronic XML invoices.
• ERP data such as purchase order or company data is provided by an ERP connector only.
• Exporting to Process Director is not supported.
• Some of the IP Configuration are not available for configuration.
• PDF generation is not supported.
• Document Export is not supported.
• Windows Authentication is not supported.

If you choose to use this deployment method, a set of database scripts and a Kofax TotalAgility package is
provided for installation into the cloud.
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Since no assemblies can be installed on the Azure server, the package includes the following.
• The IPA.dll that contains all dependencies needed to run Kofax AP Agility in the cloud.
• The Transformation Designer project that contains everything needed to run Kofax AP Agility in the

cloud.

Scan and Validation users are created and maintained within Kofax TotalAgility users and groups.

In an Azure environment, export from Kofax AP Agility is different. Instead, a Kofax TotalAgility Integration
server exports into the on-premises environment. For example, export into a file system directory.
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Kofax AP Agility installation

Kofax AP Agility processes invoices by extracting and validating data on those documents. It then takes
those documents through the accounts payable process in partnership with a back-end ERP system.

You can install Kofax AP Agility on a system where Kofax TotalAgility is installed.

Important If you are using Oracle, ensure that you have installed its prerequisite client.

If you are using SAP, ensure that you have installed its prerequisite client.

The following steps are the overall installation of Kofax AP Agility. Each step has its own set of instructions
and the order is important. Skipping steps that are not optional, or performing steps out of sequence may
result in a failed installation.

1. Extract the ZIP file

2. Run the Kofax AP Agility installer in one of the following modes.
• Full installation
• Custom installation
• Command Line or Silent installation

3. Configure your installation

4. Optionally, Change your Kofax AP Agility installation

5. Optionally, Repair Kofax AP Agility

6. Optionally, Remove a feature

7. Optionally, Remove Kofax AP Agility

Extract the ZIP file
All of the installation files necessary to install Kofax AP Agility are available in the
KofaxAPAgility-2.2.0.zip file.

You can extract the contents of the ZIP file by following these steps.
1. Right-click on the zip file and select Extract.
2. When prompted, select a location for the extracted files.

Make a note of this location for further installation steps.
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Install Kofax AP Agility
How you install Kofax AP Agility depends on your Kofax TotalAgility installations.

In some environments, Kofax TotalAgility is installed on a single server. In other environments, Kofax
TotalAgility is distributed across multiple servers. Each environment requires a different approach when
installing Kofax AP Agility.

To help with this, there are three different methods of installing Kofax AP Agility.

Full
Use the Full installation method when installing all of the Kofax AP Agility features on the same machine.

Custom
Use the Custom installation method to install one or more of the individual Kofax AP Agility features.

Command line/Silent installation
Use the command line Silent installation method to install one or more individual Kofax AP Agility features.
Use this method to install various features on multiple machines at one time, or across a network.

Full installation
Use the full installer to install all available Kofax AP Agility components or features.

These components include the following.
• AP Agility Assemblies

These assemblies are installed on this server automatically whenever the Full installer is run. No
configuration is required.
If the necessary prerequisites are installed, the following assemblies are also installed automatically.
• SAP Assemblies
• Oracle Assemblies

• MarkView Assemblies
See the Help for Kofax AP Agility Settings for more information about integrating your system to
work with MarkView.

• Kofax AP Agility Database
• Kofax TotalAgility Integration

• Kofax TotalAgility Package
• ERP Connector Web Service

If you do not require all of these features for your solution, use the Custom installation instead. The
custom installation enables you to select the specific component(s) that you require.

You can install all of the components for Kofax AP Agility using the Setup Wizard by following these steps.
1. Navigate to your extracted files and open the Installer folder.

The contents of the Installer folder are displayed.
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2. Right-click on the Kofax AP Agility installer and select Run as Administrator to begin the Setup
Wizard.
The installer opens and calculates if there is enough space on disk for the installation.

3. Once the Install Wizard confirms that there is enough disk space, click Next.
The End-User License Agreement Setup Wizard step is displayed.

4. Select I accept the terms in the License Agreement and then click Next.
The Prerequisites Setup Wizard step is displayed along with any information about missing
prerequisites.

5. The information displayed on the Prerequisites step is relevant if you are installing the listed
components only.
For example, if you receive a message that the SAP .NET connector is missing, but you are not
using SAP, ignore this message. However, if you are using one of the components listed, click
Cancel and then Finish to exit the Setup Wizard, install the required prerequisite, and then restart
the installer. Otherwise, click Next.
If you did not install the necessary prerequisites, the corresponding options are not available for
installation.
The Choose Setup Type Setup Wizard step is displayed.

6. On the Choose Setup type window, select Full.
The AP Agility Database Connection Setup Wizard step is displayed.

7. On the AP Agility Database Connection step, enter the following information to configure your
database connection.

Tip Ensure that the user specified to create this database connection has at least db_owner
permissions.

a. Enter a Database name.
A default database name is provided. If you modify the database name, note the name as it is
needed later in the installation.

b. Enter your database Server name.

c. Select your database Authentication type.
If you select Windows Authentication, this means that Integrated Security is used to connect
to the database. If you select SQL Server Authentication, Integrated Security is not used to
connect to the database.

d. If you are using SQL Server Authentication enter a User name and the corresponding User
password.

e. Click Test connection to ensure that your information is correct. If not, repeat the previous
steps and try again.

f. Once your connection test is successful, click Next.
The Kofax TotalAgility Connection Setup Wizard step is displayed.
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8. On the Kofax TotalAgility Connection step, enter the following information.

a. If the default Kofax TotalAgility URL that is provided is not correct, update the TotalAgility URL.
For example, http://<Server name>/TotalAgility/.

b. Select your Authentication type from one of the following options.
• Authentication by username and password.
• Provide Session ID.

This ID is found by navigating to the TotalAgility Designer home page. Select System
Settings > Settings.

• Windows authentication.

If you are using Authentication by username and password enter a User name and User
password.
If you are using Provide Session ID, enter the Session ID.
If you are using Windows authentication, no further action is required.

c. Click Test connection to ensure that your information is correct. If not, repeat the previous
steps and try again.

d. Once your connection test is successful, click Next.
The AP Agility ERP Connector Configuration Setup Wizard step is displayed.

9. On the AP Agility ERP Connector Configuration step, enter the following information.

a. Optionally, enter an alternate Web Site.

Note This web site must exist in IIS before it can be added here. All other items are created
dynamically.

b. Optionally, enter a different Virtual Directory.

c. Optionally, enter a different Application Pool.

d. Optionally, select a Pool Identity.
If you select Custom Account, enter a User name, User domain, and the corresponding User
Password.

e. Click Next.
The Ready to install Kofax AP Agility 2.2.0 Setup Wizard step is displayed.

10. On the Ready to install Kofax AP Agility 2.2.0 step click Install to proceed with your installation.
Otherwise, click Back to return to previous steps in the Setup Wizard.
A progress indicator shows the progress of the Kofax AP Agility installation.

11. Click Finish.
Optionally, select the View Installation Log option. This opens the log file once the installer is
closed.
The installer closes and if selected, the log file opens.

12. Now that you have run the installer, Kofax AP Agility is installed, but it does not work in your
environment. You must now configure your installation so that it works for your environment.
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Custom installation
If you do not want to install all of the components of Kofax AP Agility at the same time, or on the same
machine, you can choose which components to install.

If you want to install all Kofax AP Agility components, use the full installation instead.

The components and when they are required is as follows.

The AP Agility Assemblies
These assemblies must be installed on every server where Kofax TotalAgility is installed. This includes
any servers running Transformation Server.
If the necessary prerequisites are installed, the following assemblies are available for selection as part of
the Install AP Agility Assemblies.
• SAP Assemblies
• Oracle Assemblies

• MarkView Assemblies
See the Help for Kofax AP Agility Settings for more information about integrating your system to work
with MarkView.

The AP Agility Database
This database is installed once on a Kofax TotalAgility server or a dedicated database server.

Kofax TotalAgility Integration
This updates the Kofax TotalAgility variables that are used by Kofax AP Agility.

Kofax TotalAgility Package
This installs the Kofax AP Agility package for Kofax TotalAgility. This is installed once and then used
by all Kofax TotalAgility servers.

The ERP Connector Web Service
This installs and configures the ERP connector web service and its components.

Here are the most common scenarios for installing Kofax AP Agility with a list of components that are
required in each scenario.
• On your Kofax TotalAgility development or production environments you can install all of the Kofax AP

Agility components.
However, if you have a separate database server, you can point to your database server with this
installer. This means the all necessary components for integrating with Kofax TotalAgility are installed,
even if they are not on the same server where the installer is executed.
Also, if you have a separate web server, it is possible to install the ERP web service separately on
that server. If you have both a development and a production server, a separate ERP web service
installation is required.

• On Kofax TotalAgility additional servers, install the Kofax AP Agility assemblies only. This includes any
additional assemblies for SAP, Oracle, or MarkView.

• If you are using both a development server and a production server it is necessary that each server has
its own separate Kofax AP Agility database and ERP installations.
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You can use the Custom Setup by following these steps.
1. Navigate to your extracted files and open the Installer folder.

The contents of the Installer folder are displayed.
2. Right-click on the Kofax AP Agility installer and select Run as Administrator to begin the Setup

Wizard.
The installer opens and calculates if there is enough space on disk for the installation.

3. Once the Install Wizard confirms that there is enough disk space, click Next.
The End-User License Agreement Setup Wizard step is displayed.

4. Select I accept the terms in the License Agreement and then click Next.
The Prerequisites Setup Wizard step is displayed along with any information about missing
prerequisites.

5. The information displayed on the Prerequisites step is relevant if you are installing the listed
components only.
For example, if you receive a message that the SAP .NET connector is missing, but you are not
using SAP, ignore this message. However, if you are using one of the components listed, click
Cancel and then Finish to exit the Setup Wizard, install the required prerequisite, and then restart
the installer. Otherwise, click Next.
If you did not install the necessary prerequisites, the corresponding options are not available for
installation.
The Choose Setup Type Setup Wizard step is displayed.

6. On the Choose Setup type window, select Custom.
The Custom Setup step is displayed along with a list of available components.

7. On the Custom Setup step, a list of features is listed. By default, all of the listed features are
configured for installation. If you do not want to install one or more features, select Entire feature
will be unavailable for each of those features.
Once you select the necessary components, click Next.
Most of the selected components require further configuration. As a result, depending on what you
select, additional Setup Wizard steps are available.
Use the links below to install each of the following features as appropriate for your installation.
• AP Agility assemblies
• AP Agility database connection
• Kofax TotalAgility Integration/package
• ERP Connector Web Service

8. Now that you have run the installer, Kofax AP Agility is installed, but it does not work in your
environment. You must now configure your installation so that it works for your environment.

Install AP Agility Assemblies
For the assemblies, no additional configuration is required.

If the necessary prerequisites for SAP or Oracle are installed, their associated client assemblies are
available for selection when you install the assemblies. These additional assemblies are not selected by
default.

For example, if you have the Oracle prerequisites installed, this enables the selection of the MarkView
assemblies. If you want to use the Oracle assemblies and not the MarkView assemblies, ensure that the
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Oracle assemblies are set to Will be installed on local hard drive and that the MarkView assemblies are
set to Entire feature will be unavailable.

The following steps assume that you are installing the assemblies only. If you do select additional
features, refer back to the Custom installation for their individual installation instructions.

You can install the AP Agility Assemblies and any valid client assemblies by following these steps.
1. On the Custom Setup step, ensure that the required AP Agility Assemblies are set to Will be

installed on local hard drive.
2. Optionally, if you want to use SAP, Oracle, or MarkView and their assemblies are displayed, set them

to Will be installed on local hard drive.
3. Click Next.

The Ready to install Kofax AP Agility 2.2.0 Setup Wizard step is displayed.
4. On the Ready to install Kofax AP Agility 2.2.0 step click Install to proceed with your installation.

Otherwise, click Back to return to previous steps in the Setup Wizard.
A progress indicator shows the progress of the Kofax AP Agility installation.

5. Click Finish.
Optionally, select the View Installation Log option. This opens the log file once the installer is
closed.
The installer closes and if selected, the log file opens.

Install AP Agility Database Connection
Install the AP Agility database once on any Kofax TotalAgility server or a dedicated database server.

The following steps assume that you are installing the AP Agility database only. If you do select additional
features, refer back to the Custom installation for their individual installation instructions.

You can install the AP Agility database by following these steps.
1. On the Custom Setup step, ensure that the AP Agility Database is set to Will be installed on the

local hard drive and then click Next.
The AP Agility Database Connection Setup Wizard step is displayed.
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2. On the AP Agility Database Connection step, enter the following information to configure your
database connection.

Tip Ensure that the user specified to create this database connection has at least db_owner
permissions.

a. Enter a Database name.
A default database name is provided. If you modify the database name, note the name as it is
needed later in the installation.

b. Enter your database Server name.

c. Select your database Authentication type.
If you select Windows Authentication, this means that Integrated Security is used to connect
to the database. If you select SQL Server Authentication, Integrated Security is not used to
connect to the database.

d. If you are using SQL Server Authentication enter a User name and the corresponding User
password.

e. Click Test connection to ensure that your information is correct. If not, repeat the previous
steps and try again.

f. Once your connection test is successful, click Next.
The Kofax TotalAgility Connection Setup Wizard step is displayed.

3. On the Ready to install Kofax AP Agility 2.2.0 step click Install to proceed with your installation.
Otherwise, click Back to return to previous steps in the Setup Wizard.
A progress indicator shows the progress of the Kofax AP Agility installation.

4. Click Finish.
Optionally, select the View Installation Log option. This opens the log file once the installer is
closed.
The installer closes and if selected, the log file opens.

Kofax TotalAgility integration and package
If you select Kofax TotalAgility Integration, the Kofax TotalAgility Package is selected automatically. You
cannot install one without the other.

The following steps assume that you are installing the Kofax TotalAgility integration and package only.
If you do select additional features, refer back to the Custom installation for their individual installation
instructions.

If you are installing the Kofax TotalAgility integration and package only, the Install AP Agility Database
Connection step is displayed by default. However, you can skip this step if you do not want to configure it
at this time.

However, if you do skip the database step, it is necessary to manually enter this information at a later
time.
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You can install the Kofax TotalAgility integration and package by following these steps.
1. On the Custom Setup step, ensure that the Kofax TotalAgility Integration and the Kofax

TotalAgility Package are set to Will be installed on local hard drive and then click Next.
The AP Agility Database Connection Setup Wizard step is displayed.
If you do not have the necessary information to set up the AP Agility Database Connection, click
Skip to skip the next step.

2. On the AP Agility Database Connection step, enter the following information to configure your
database connection.

Tip Ensure that the user specified to create this database connection has at least db_owner
permissions.

a. Enter a Database name.
A default database name is provided. If you modify the database name, note the name as it is
needed later in the installation.

b. Enter your database Server name.

c. Select your database Authentication type.
If you select Windows Authentication, this means that Integrated Security is used to connect
to the database. If you select SQL Server Authentication, Integrated Security is not used to
connect to the database.

d. If you are using SQL Server Authentication enter a User name and the corresponding User
password.

e. Click Test connection to ensure that your information is correct. If not, repeat the previous
steps and try again.

f. Once your connection test is successful, click Next.
The Kofax TotalAgility Connection Setup Wizard step is displayed.

18



Kofax AP Agility Installation Guide

3. On the Kofax TotalAgility Connection step, enter the following information.

a. If the default Kofax TotalAgility URL that is provided is not correct, update the TotalAgility URL.
For example, http://<Server name>/TotalAgility/.

b. Select your Authentication type from one of the following options.
• Authentication by username and password.
• Provide Session ID.

This ID is found by navigating to the TotalAgility Designer home page. Select System
Settings > Settings.

• Windows authentication.

If you are using Authentication by username and password enter a User name and User
password.
If you are using Provide Session ID, enter the Session ID.
If you are using Windows authentication, no further action is required.

c. Click Test connection to ensure that your information is correct. If not, repeat the previous
steps and try again.

d. Once your connection test is successful, click Next.
The Ready to install Kofax AP Agility 2.2.0 Setup Wizard step is displayed.

4. On the Ready to install Kofax AP Agility 2.2.0 step click Install to proceed with your installation.
Otherwise, click Back to return to previous steps in the Setup Wizard.
A progress indicator shows the progress of the Kofax AP Agility installation.

5. Click Finish.
Optionally, select the View Installation Log option. This opens the log file once the installer is
closed.
The installer closes and if selected, the log file opens.

Install ERP Connector Web Service
Install the ERP Connector Web Service once for your Kofax TotalAgility environment. This can be on a
Kofax TotalAgility server or a dedicated Web Server.

The following steps assume that you are installing the ERP Connector Web Service only. If you do select
additional features, refer back to the Custom installation for their individual installation instructions.

You can install the ERP Connector Web Service by following these steps.
1. On the Custom Setup step, ensure that the ERP Connector Web Service is set to Will be

installed on local hard drive and then click Next.
The Kofax TotalAgility Connection Setup Wizard step is displayed.
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2. On the Kofax TotalAgility Connection step, enter the following information.

a. If the default Kofax TotalAgility URL that is provided is not correct, update the TotalAgility URL.
For example, http://<Server name>/TotalAgility/.

b. Select your Authentication type from one of the following options.
• Authentication by username and password.
• Provide Session ID.

This ID is found by navigating to the TotalAgility Designer home page. Select System
Settings > Settings.

• Windows authentication.

If you are using Authentication by username and password enter a User name and User
password.
If you are using Provide Session ID, enter the Session ID.
If you are using Windows authentication, no further action is required.

c. Click Test connection to ensure that your information is correct. If not, repeat the previous
steps and try again.

d. Once your connection test is successful, click Next.
The AP Agility ERP Connector Configuration Setup Wizard step is displayed.

3. On the AP Agility ERP Connector Configuration step, enter the following information.

a. Optionally, enter an alternate Web Site.

Note This web site must exist in IIS before it can be added here. All other items are created
dynamically.

b. Optionally, enter a different Virtual Directory.

c. Optionally, enter a different Application Pool.

d. Optionally, select a Pool Identity.
If you select Custom Account, enter a User name, User domain, and the corresponding User
Password.

e. Click Next.
The Ready to install Kofax AP Agility 2.2.0 Setup Wizard step is displayed.

4. On the Ready to install Kofax AP Agility 2.2.0 step click Install to proceed with your installation.
Otherwise, click Back to return to previous steps in the Setup Wizard.
A progress indicator shows the progress of the Kofax AP Agility installation.

5. Click Finish.
Optionally, select the View Installation Log option. This opens the log file once the installer is
closed.
The installer closes and if selected, the log file opens.
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Command Line installation and parameters
It is possible to use the Command Line to install Kofax AP Agility. This type of installation provides you
with more control over configuration settings during installation so that you can remotely deploy the
software across the network. You can also use the command line if you want to use a silent installation.

You can use the MSI installer if you want to install the software onto multiple machines over a network,
and do not want to visit each machine individually.

If a parameter is not included in a command, its default value is used.

For example, the following commands are some of many examples for installing Kofax AP Agility.

This first example installs the basic assemblies and the SAP assemblies only.
msiexec /i "Kofax AP Agility.msi" /qn SAP_INSTALLATION_TYPE=1
 DATABASE_INSTALLATION_TYPE=0 KTA_INT_INSTALLATION_TYPE=0 KTA_PKG_INSTALLATION_TYPE=0 
 ERP_CONNECTOR_INSTALLATION_TYPE=0

This second example installs the agnostic ERP connector only, along with detailed logging.
msiexec /i "Kofax AP Agility.msi" /qn  /norestart BASIC_INSTALLATION_TYPE=0
 DATABASE_INSTALLATION_TYPE=0 KTA_INT_INSTALLATION_TYPE=0 KTA_PKG_INSTALLATION_TYPE=0
 ERP_CONNECTOR_INSTALLATION_TYPE=1 KTA_URL="http://localhost/TotalAgility/"
 KTA_LOGIN_TYPE="WINDOWS" APA_IIS_POOL_IDENTITY_TYPE=LOCALSYSTEM

For more information about the msiexec.exe options, see the Microsoft MSDN description of Command
Line options.

The following parameters are available when installing Kofax AP Agility.

Command Line Parameters

Parameter Description and Value Options

BASIC_INSTALLATION_TYPE This parameter is mandatory and must be included in the
installation command. If this parameter is not included, its default
value is applied.
The default value for this parameter is 1.
When this parameter value is set to 1 the basic assemblies
required by Kofax AP Agility are installed.
When this parameter value is set to 0 the installation of the basic
assemblies and all other assembly types are skipped.
For assemblies, the hierarchy is as follows.
• Kofax AP Agility assemblies

• SAP assemblies
• Oracle assemblies

• MarkView assemblies

This hierarchy means that child assemblies can only be installed
when their parent is installed.
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Parameter Description and Value Options

SAP_INSTALLATION_TYPE This parameter is mandatory and must be included in the
installation command. If this parameter is not included, its default
value is applied.
The default value for this parameter is 0, but it cannot be installed
if the BASIC_INSTALLATION_TYPE=0. This is because the
basic assemblies are required for the SAP assemblies.
When this parameter value is set to 1 the SAP assemblies
required by Kofax AP Agility are installed. However, if the
prerequisites for SAP are not installed, this is skipped, even if its
value is set to 1.
When this parameter value is set to 0 the installation of the SAP
assemblies is skipped.

ORACLE_INSTALLATION_TYPE This parameter is mandatory and must be included in the
installation command. If this parameter is not included, its default
value is applied.
The default value for this parameter is 0, but it cannot be installed
if the BASIC_INSTALLATION_TYPE=0. This is because the
basic assemblies are required for the Oracle assemblies.
When this parameter value is set to 1 the Oracle assemblies
required by Kofax AP Agility are installed. However, if the
prerequisites for Oracle are not installed, this is skipped, even if
its value is set to 1.
When this parameter value is set to 0 the installation of the
Oracle assemblies is skipped.

MARKVIEW_INSTALLATION_TYPE This parameter is mandatory and must be included in the
installation command. If this parameter is not included, its default
value is applied.
The default value for this parameter is 0, but it cannot be installed
if the BASIC_INSTALLATION_TYPE=0. This is because the
basic assemblies are required for the MarkView assemblies.
Similarly, if the ORACLE_INSTALLATION_TYPE=0, you cannot
install the MarkView assemblies.
When this parameter value is set to 1 the MarkView assemblies
required by Kofax AP Agility are installed. However, if the
prerequisites for Oracle and MarkView are not installed, this is
skipped, even if its value is set to 1.
When this parameter value is set to 0 the installation of the
MarkView assemblies is skipped.

DATABASE_INSTALLATION_TYPE This parameter is mandatory and must be included in the
installation command. If this parameter is not included, its default
value is applied.
The default value for this parameter is 1.
When this parameter value is set to 1 the Kofax AP Agility
database is installed based on several additional SQL
parameters.
When this parameter value is set to 0 the installation of the Kofax
AP Agility database is skipped.
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Parameter Description and Value Options

SQL_SERVER_NAME This parameter is mandatory if you set
DATABASE_INSTALLATION_TYPE=1.
This is the name of the SQL Server where you want to create the
Kofax AP Agility database.

SQL_DATABASE_NAME This parameter is mandatory if you set
DATABASE_INSTALLATION_TYPE=1.
This is the name of the SQL database. By default, this is set to
InvoiceProcessingAgility_Client. Edit the database
name if necessary.

SQL_AUTHENTICATION_TYPE This parameter is mandatory if you set
DATABASE_INSTALLATION_TYPE=1.
Set this parameter to WINDOWS for Windows Authentication.
Alternatively, set it to SQL_SERVER to use SQL Server
authentication.

SQL_USER_NAME This parameter is mandatory if you set
SQL_AUTHENTICATION_TYPE=SQL_SERVER.
Set this parameter to the name of the SQL user.

SQL_USER_PASS This parameter is mandatory if you set
SQL_AUTHENTICATION_TYPE=SQL_SERVER.
Set this parameter to the password of the SQL user.

SKIP_DATABASE_INT This parameter is required in one specific scenario only. It
is available only if KTA_INT_INSTALLATION_TYPE=1 and
DATABASE_INSTALLATION_TYPE=0. In this case, it is possible
to skip updating the database variable in Kofax TotalAgility if
you do not have the database details to hand. The database
configuration can be done at a later time.

KTA_INT_INSTALLATION_TYPE This parameter is mandatory and must be included in the
installation command. If this parameter is not included, its default
value is applied.
The default value for this parameter is 1.
When this parameter is set to 1 the Kofax TotalAgility variables
that are used by Kofax AP Agility are updated.
When set to 0, no variables are updated and the Kofax
TotalAgility package is not installed.

KTA_PKG_INSTALLATION_TYPE This parameter is mandatory and must be included in the
installation command. If this parameter is not included, its default
value is applied.
The default value for this parameter is 1.
When this parameter is set to 1 the Kofax AP Agility package for
Kofax TotalAgility is installed.
When set to 0, the package is not installed.
This is a child of KTA_INT_INSTALLATION_TYPE. This means
that you cannot install the child without installing the parent.

KTA_URL This parameter is mandatory if you set
KTA_INT_INSTALLATION_TYPE=1.
Enter the name of the URL used by Kofax TotalAgility.
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Parameter Description and Value Options

KTA_LOGIN_TYPE This parameter is mandatory if you set
KTA_INT_INSTALLATION_TYPE=1.
This parameter can be set to the following authentication types.
• WINDOWS for Windows authentication
• USERNAMEANDPASSWORD for Kofax TotalAgility local

authentication
• SESSIONID for session-specific authentication

KTA_USERNAME This parameter is mandatory if you set
KTA_LOGIN_TYPE=USERNAMEANDPASSWORD.
Enter the Kofax TotalAgility user name.

KTA_PASSWORD This parameter is mandatory if you set
KTA_LOGIN_TYPE=USERNAMEANDPASSWORD.
Enter the Kofax TotalAgility user password.

KTA_SESSIONID This parameter is mandatory if you set
KTA_LOGIN_TYPE=SESSIONID.
Enter the Kofax TotalAgility session id.

ERP_CONNECTOR_INSTALLATION_TYPE This parameter is mandatory and must be included in the
installation command. If this parameter is not included, its default
value is applied.
The default value for this parameter is 1.
When this parameter is set to 1 the agnostic ERP connector is
installed.
When set to 0, the package is not installed.

APA_IIS_WEBSITE_NAME This parameter is mandatory if you set 
ERP_CONNECTOR_INSTALLATION_TYPE=1.
This is the name of the IIS Web Site that you want to use. By
default, this is set to the Default Web Site.

APA_IIS_VIRTUAL_DIRECTORY_NAME This parameter is mandatory if you set 
ERP_CONNECTOR_INSTALLATION_TYPE=1.
This is the name of the IIS Virtual Directory that you want to use.
This is set to ApAgilityErpConnector by default.

APA_IIS_APP_POOL This parameter is mandatory if you set 
ERP_CONNECTOR_INSTALLATION_TYPE=1.
This is the name of the IIS Pool name. This is set to
ErpConnectorServiceAppPool by default.

APA_IIS_POOL_IDENTITY_TYPE This parameter is mandatory if you set FTR_ERPWS.
Choose from one of the following identity types for your
application pool.
• LOCALSERVICE

• LOCALSYSTEM

• NETWORKSERVICE

• APPPOOLIDENTITY

• CUSTOMACCOUNT
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Parameter Description and Value Options

APA_IIS_APP_POOL_USERNAME This parameter is mandatory if you set
APA_IIS_POOL_IDENTITY_TYPE=CUSTOMACCOUNT.
Enter the name of the user for the IIS Pool.

APA_IIS_APP_POOL_USERPASSWORD This parameter is mandatory if you set
APA_IIS_POOL_IDENTITY_TYPE=CUSTOMACCOUNT.
Enter the password of the user for the IIS Pool.

APA_IIS_APP_POOL_USERDOMAIN This parameter is mandatory if you set
APA_IIS_POOL_IDENTITY_TYPE=CUSTOMACCOUNT.
Enter the domain of the user for the IIS Pool.

Important Some of the above parameters work in a hierarchy. This means that if your command
explicitly installs a child, but explicitly does not install the parent, neither are installed.

For example, your command includes the following installation type parameters.
BASIC_INSTALLATION_TYPE=0 SAP_INSTALLATION_TYPE=0 ORACLE_INSTALLATION_TYPE=0 
MARKVIEW_INSTALLATION_TYPE=1

In this scenario, even though you want to install the MarkView assemblies, nothing is installed. This is
because the MarkView assemblies are a child of the Oracle assemblies, which are also a child of the
basic Kofax AP Agility assemblies.

If you want to install MarkView assemblies, you need to add the following parameters to your command.
BASIC_INSTALLATION_TYPE=1 SAP_INSTALLATION_TYPE=0 ORACLE_INSTALLATION_TYPE=1 
MARKVIEW_INSTALLATION_TYPE=1

Silent installation
If you do not want to perform an interactive installation of Kofax AP Agility, you can use a silent
installation. This automatic installation does not display configuration, progress, feature information or
warning messages. It does however, display any error messages.

The following parameters can be added to the command line for a silent installation.

Parameter Description and Value Options

/? or /h Displays the help for the command.

/quiet, /q, or /qn Runs the installer with no user interaction.

l*v [filename] Writes the installer log messages to the specified file.

/x Removes the product.

/i Installs the product.

<property>=<value> Passes additional parameters to the installer.

/qn+ Runs installer with no user interaction except that there is a message
window displayed at the end of the silent installation.
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You can install Kofax AP Agility using the silent install by following these steps.
1. Locate the Command Prompt on your computer.

If you are an Administrator, double-click to open the application. If you are not an Administrator, right-
click and select Run as administrator.
The Command Prompt opens.

2. Navigate to where you extracted the ZIP file and the installer.
3. Enter the command to install the features that you need.

For example, use the following command to silently install the base assemblies, the database, Kofax
TotalAgility integration, and the Kofax TotalAgility package, but not the agnostic ERP connector. In
addition, a log records the installation steps.
msiexec /i "Kofax AP Agility.msi" /l*v APAgilitySetupLOG.txt /
q BASIC_INSTALLATION_TYPE=1 DATABASE_INSTALLATION_TYPE=1
 ERP_CONNECTOR_INSTALLATION_TYPE=0 SQL_SERVER_NAME=localhost
 SQL_DATABASE_NAME=ApAgility  SQL_AUTHENTICATION_TYPE=SQL_SERVER
 SQL_USER_NAME=<username> SQL_USER_PASS=<password> KTA_URL=http://localhost/
TotalAgility KTA_LOGIN_TYPE=WINDOWS

Since the default behavior for the agnostic ERP connector is to install this feature, the above
example overrides this by explicitly saying not to install the agnostic ERP connector.
If however, you want to see the results of the silent installation, you can create a PowerShell or batch
script that checks the installer results. Alternatively, you can use the /qn+ parameter. The following
three examples show the various options.

a. A batch file.
msiexec.exe /i "Kofax AP Agility.msi" /qn  /l*v netfx.log

if "%errorlevel%" == "0" goto OK
if "%errorlevel%" == "1013" goto ERR
if "%errorlevel%" == "1603" goto ERR
if not "%errorlevel%" == "0" goto ERR

:OK
echo "Installation completed successfully"
GOTO END

:ERR
echo "Error: Msiexec failed with errorlevel = %errorlevel%"
exit /b %errorlevel%

:END

b. PowerShell script.
$msi = "<Location of AP Agility Installer>\Kofax AP Agility.msi"
$name = "Kofax_ApAgility"
$list = 
@(
    "/I `"$msi`"",                     # Install this MSI
    "/QN",                             # Quietly, without a UI
    "/L*V `"$ENV:TEMP\$name.log`""     # Verbose output to this log
)

Start-Process -FilePath "msiexec" -ArgumentList $list -Wait
$p = Start-Process -FilePath "msiexec" -ArgumentList $list -Wait -PassThru

if($p.ExitCode -ne 0 -and $p.ExitCode -ne 3010 -and $p.ExitCode -ne 1641)
{
     Write-Output "Installation process returned error code: $($p.ExitCode)"
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}
else
{
    Write-Output "Installation process completed successfully with code:
 $($p.ExitCode)"
}

c. The /qn+ parameter.
msiexec /I "Kofax AP Agility.msi"  /qn+

4. Now that you have run the installer, Kofax AP Agility is installed, but it does not work in your
environment. You must now configure your installation so that it works in your environment.

On-premise installation for Kofax AP Agility hosted on Microsoft Azure
After Kofax provides your credentials to log on to Kofax AP Agility in the cloud, it is necessary to install
additional on-premise components to use Kofax AP Agility.

The following components are required.

1. Install the Kofax TotalAgility Integration Server.
For more information see the Kofax TotalAgility Integration Server Installation Guide.

2. Extract the KofaxAPAgility-2.2.0.zip file.

3. Install and configure your ERP connector.
For more information, see the Help for Kofax AP Agility Settings.
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Configure your Kofax AP Agility installation

The following steps are necessary after installing Kofax AP Agility. Each step contains its own set of
instructions and the order is important. Skipping steps that are not optional, or performing steps out of
sequence can result in a failed installation.

The configuration of your Kofax AP Agility installation is broken down into three parts.

1. Configuration steps that apply to the functionality of entire product
• Optionally, if you are using Windows Authentication, configure the authentication type.
• Optionally, if you installed the Agnostic ERP via the installer, several additional changes are

required.
• Alternatively, integrate another ERP system.

2. Configuration steps that are specific to the Invoice processing functionality.
• Configure invoice processing administrative resource access.
• CSV files for database lookups.
• Configure document ingestion.
• Optionally, configure Use Exit assemblies.
• Optionally, install PIX.
• Optionally, modify the recognition engines in the Transformation Designer.

This step is necessary if you are processing documents in languages other than English only.

3. Configuration steps that are specific to the AP Agility workflow functionality
• Configure AP Agility workflow administrative resource access

General Configuration for Kofax AP Agility
There are several steps required to configure Kofax AP Agility that are independent of how you plan to
process invoices.

Before you can start to use Kofax AP Agility you can perform the following tasks as needed.
• Install Kofax AP Agility assemblies on other Kofax TotalAgility servers
• Configure Windows authentication behavior
• Locale and time zone configuration
• Integration with Enterprise Resource Planning systems
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Install Kofax AP Agility assemblies on other Kofax TotalAgility servers
After installing Kofax AP Agility, it is still necessary to install the Kofax AP Agility assemblies on all
other Kofax TotalAgility servers, such as the Transformation Server or the Integration Server. For more
information on other types of Kofax TotalAgility servers, refer to the Kofax TotalAgility Installation Guide.

You can install the Kofax AP Agility assemblies on other Kofax TotalAgility servers by following these
steps.

1. Copy the extracted files to the server where you are installing the Kofax AP Agility assemblies.
2. Navigate to your extracted files and open the Installer folder.

The contents of the Installer folder are displayed.
3. Right-click on the Kofax AP Agility installer and select Run as Administrator to begin the Setup

Wizard.
The installer opens and calculates if there is enough space on disk for the installation.

4. Once the Install Wizard confirms that there is enough disk space, click Next.
The End-User License Agreement Setup Wizard step is displayed.

5. Select I accept the terms in the License Agreement and then click Next.
The Prerequisites Setup Wizard step is displayed along with any information about missing
prerequisites.

6. The information displayed on the Prerequisites step is relevant if you are installing the listed
components only.
For example, if you receive a message that the SAP .NET connector is missing, but you are not
using SAP, ignore this message. However, if you are using one of the components listed, click
Cancel and then Finish to exit the Setup Wizard, install the required prerequisite, and then restart
the installer. Otherwise, click Next.
If you did not install the necessary prerequisites, the corresponding options are not available for
installation.
The Choose Setup Type Setup Wizard step is displayed.

7. On the Choose Setup type window, select Custom.
The Custom Setup step is displayed along with a list of available components.

8. On the Custom Setup step, ensure that the required Assemblies are set to Will be installed on
local hard drive and then click Next.
The Ready to install Kofax AP Agility 2.2.0 Setup Wizard step is displayed.

9. On the Ready to install Kofax AP Agility 2.2.0 step click Install to proceed with your installation.
Otherwise, click Back to return to previous steps in the Setup Wizard.
A progress indicator shows the progress of the Kofax AP Agility installation.

10. Click Finish.
Optionally, select the View Installation Log option. This opens the log file once the installer is
closed.
The installer closes and if selected, the log file opens.

Configure Windows authentication behavior
By default, Kofax AP Agility is configured so that it does not use Windows authentication.
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If you want to use Windows authentication you can modify how Kofax AP Agility works within Kofax
TotalAgility so that is uses Window authentication.

Note If you are using Kofax AP Agility in an Azure environment, you cannot use Windows
authentication.

You can configure Kofax AP Agility to use Windows authentication by following these steps.
1. Logon to the TotalAgility Designer.
2. On the Home page, click Form Designer.

The Form Designer page is displayed.
3. In the Explorer pane, select Sites.

The Explorer pane is replaced with the Sites pane.
4. From the Category list, select AP Agility.

A list of available categories is displayed.
5. Click on the icon to the left of AP Agility and click Open.

The Site configuration page is displayed.
6. In the left Consume pane, select Form.
7. From the list, select AP Agility.

A list of available forms is displayed.
8. Drag the APA_Workspage_Logon_Windows_Authentication form to the Default Form option in

the Desktop Settings group.
9. Click Save in the upper left corner.

The Form Designer page is displayed once more.
10. On the Form Designer page, in the Manage group, click Global Variables.
11. From the Category Filter list, select AP Agility.

A list of available variables is displayed.
12. Select the APA_Use_Windows_Authentication variable and set its value to True.
13. Save your changes.
14. Optionally, close the TotalAgility Designer.

Locale and time zone configuration
After you install Kofax AP Agility, verify that the locale and the time zone for the server where Kofax AP
Agility is installed and for the server from where you connect to Kofax AP Agility are the same.

Set secure connection strings
The Kofax AP Agility processes and forms use connection strings for the Kofax AP Agility database that
are specified within the Kofax TotalAgility server and global variables.

You can ensure that your connection strings for Kofax AP Agility are secure by following these steps.
1. Open the TotalAgility Designer.

The TotalAgility Designer Home page is displayed.
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2. Configure the database server variable for the Kofax AP Agility Processes by following these steps.

a. On the TotalAgility Designer Home page, select Data.
The Data page is displayed.

b. On the Data page, in the Manage group, click Server Variables.
The Server Variables page is displayed.

c. From the Category Filter list, select AP Agility.
The list of variables is updated for the AP Agility category.

d. In the list of variables, locate and then click DB Connection String.
The variable values are populated into the fields above the list of variables.

e. In the editable fields, set Secure to Yes.
When prompted, click Yes.
This ensures that the entire variable is encrypted so that it is not visible anywhere in Kofax
TotalAgility.

f. In the editable fields, click Configure.
The String Variable page is displayed.

g. In the editable field, enter the connection string to the Kofax AP Agility database.
This string is located in Kofax AP Agility at Settings > IP Configuration > Global settings >
Database Connection Settings.

Note When you change the variable so that it is secure, that action clears the variable value.

h. Click OK in the upper right corner.
You are returned to the list of variables.

3. Configure the database global variable for the Kofax AP Agility Forms.

a. On the TotalAgility Designer Home page, click Form Designer.
The Form Designer page is displayed.

b. On the Form Designer page, in the Manage group, click Global Variables.
A list of variables is displayed for the default category.

c. From the Category Filter list, select AP Agility.
The list of variables is updated for the AP Agility category.

d. In the list of variables, locate and then click APA_Connection_String.
The variable values are populated into the fields above the list of variables.

e. For the variable, set Secure to Yes.
Ensure that the string listed matches the string defined in Kofax AP Agility at Settings > IP
Configuration > Global settings > Database Connection Settings.

f. Save the variable.

Note If you change the database global variables in the future, you must restart the web
browser and clear the browser cache.
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4. Configure the database global variable for the Invoice processing Forms.

a. In the list of AP Agility variables, locate and then click IPA_Connection_String.
The variable values are populated into the fields above the list of variables.

b. For the variable, set Secure to Yes.
Ensure that the string listed matches the string defined in Kofax AP Agility at Settings > IP
Configuration > Global settings > Database Connection Settings.

c. Save the variable.

Note If you change the database global variables in the future, you must restart the web
browser and clear the browser cache.

5. Configure the database global variable for the Invoice processing configuration.

a. From the Category Filter list, select InvoiceProcessingAgility > IP Configuration.
The list of variables is updated for the IP Configuration category.

b. In the list of variables, locate and then click IPAConnectionString.
The variable values are populated into the fields above the list of variables.

c. For the variable, set Secure to Yes.
Ensure that the string listed matches the string defined in Kofax AP Agility at Settings > IP
Configuration > Global settings > Database Connection Settings.

d. Save the variable.

Note If you change the database global variables in the future, you must restart the web
browser and clear the browser cache.

6. Optionally, return to the TotalAgility Designer Home page.

Integration with Enterprise Resource Planning systems
Kofax AP Agility exports all validated and approved invoices to the Enterprise Resource Planning system
(ERP) through a connector plugin. When you first install Kofax AP Agility, you can choose to install the
Agnostic ERP connector. The Agnostic ERP integration provides an ERP-neutral way of integration by
transferring data to and from folders. The Kofax AP Agility Administrator specifies the output file system
folder and the file name format for exported invoices. The administrator creates an invoice image in the
original format and metadata (XML, CSV) files in the specified folder for all exported invoices.

In addition to the Agnostic ERP connector, Kofax AP Agility provides plugins for the following ERPs:
• PeopleSoft
• Microsoft Dynamics
• Infor Lawson

Install PeopleSoft connector
If you are using the PeopleSoft ERP system, it is necessary to install the PeopleSoft ERP connector
in addition to the Agnostic ERP connector. You cannot install this connector without the Agnostic ERP
connector.
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If you did not install the Agnostic ERP connector when you installed Kofax AP Agility, you must first install
the Agnostic ERP connector using the custom installation before installing the PeopleSoft ERP connector.

If the Agnostic ERP connector is installed, you can install the PeopleSoft ERP connector by following
these steps.

1. Download the KofaxAPAgilityERPConnector-2.2.0_For_PeopleSoft.ZIP file from the Kofax Fulfillment
Site and extract it on a local drive available to your users.
Note the extraction location as this is needed in subsequent steps after you install the connector.

2. Copy the contents in ERP Connector\bin from the extracted files to the bin folder in IIS where
the ERP connector files are stored.
By default, this path is <Program Files>\Kofax\APAgility\Web\bin.
The PeopleSoft connector is installed and ready for integration with Kofax AP Agility.

PeopleSoft integration

You can integrate PeopleSoft with Kofax AP Agility by following these steps.
1. On the filesystem, navigate to where the extracted contents of the

KofaxAPAgilityERPConnector-2.2.0_For_PeopleSoft.zip file are located.
You extracted this file when the PeopleSoft connector was installed.

2. Navigate to the ERP_Integration\PeopleSoft folder.
This folder contains the KofaxConnector_For_PeopleSoft.zip file.

3. Extract the KofaxConnector_For_PeopleSoft.zip file.
The KOFAX_CONNECTOR folder is extracted.

4. Start the PeopleSoft Application Designer.
5. From the menu, select Tools > Copy Project > From File.

The Copy From File : Select Project window appears.
6. Select the KOFAX_CONNECTOR project and options from the Copy From File : Select Project

window and perform the following steps.

a. Navigate to and select the KOFAX_CONNECTOR folder.
Under Name, KOFAX_CONNECTOR appears, and KOFAX_CONNECTOR appears under
Select Project from the List Below.

b. Click Select to the right of the Select Project from the List Below box.
The Copy From File window appears.

c. Click Select All to select all definition types.

d. Click Copy.
The project and its definition types are installed.

33

https://delivery.kofax.com/
https://delivery.kofax.com/


Kofax AP Agility Installation Guide

7. Open PeopleSoft in a compatible web browser and configure KOFAX_APA_SERVICE by performing
the following steps.

a. Go to PeopleTools > Integration Broker > Integration Setup > Services.

b. Open KOFAX_APA_SERVICE.
Information about KOFAX_APA_SERVICE and a list of service operations is displayed.

c. Open one of the KOFAX_APA_SERVICE service operations and click Service Operation
Security.

d. Set the PTPT1000 permission to Full Access and click Save.

e. Repeat steps 7.c–7.d until all of the KOFAX_APA_SERVICE service operations have been
configured.

8. Create the ERP connection. Complete the information in the fields. In the Connection Type field,
select PeopleSoft v9.2.

9. Set up an organization to use the ERP connection.
For more information on configuring organizations, refer to the Help for Kofax AP Agility Settings.

PeopleSoft invoice export

Additional settings are needed to enable invoice export from PeopleSoft. The ChartFields settings are
used for GL segments for invoices. If the buyer does not have access to the ChartFields settings, GL
segment values from exported invoices are ignored and replaced by default values. You can enable
buyers to access these settings by following these steps.

1. Start PeopleSoft.
2. In the PeopleSoft menu, select Navigator > eSettlements > Buyer Information > Review Buyer

Details.
3. Select the buyer who should have access.

The Review Buyer Details window for that buyer appears.
4. Click the ChartField Configuration tab.
5. Change the Supplier Access settings for the buyer to make applicable GL segments editable.
6. Save the settings.

Install Microsoft Dynamics AX ERP connector
If you are using the Microsoft Dynamics ERP, it is necessary to integrate it with your Kofax AP Agility
installation.

You can install the Microsoft Dynamics AX (DAX) ERP connector by following these steps.
1. Download the KofaxAPAgilityERPConnector-2.2.0_For_DAX.ZIP from the Kofax Fulfillment

Site.
2. Extract the zip file contents on a local drive that is available to your users.
3. Copy the contents in ERP Connector\bin from the extracted files to the bin folder in IIS where

the ERP connector files are stored.
By default, this path is <Program Files>\Kofax\APAgility\Web\bin.
The Microsoft Dynamics connector is installed and ready for integration with Kofax AP Agility.
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Microsoft Dynamics AX integration

In order to integrate Microsoft Dynamics AX so that it can be used, you must perform the following steps
in the specified order.

1. Install the Dynamics AX ERP web service

2. Enable SSL

3. Test your installation

4. Configure Dynamics AX 2012

5. Configure the Dynamics AX ERP web service

6. Final steps

Install the Dynamics AX ERP web service

You can install the Dynamics AX ERP web service by following these steps.
1. Extract the ERP Integration\MSDynamics\KofaxConnector_For_DAX.zip file.
2. Copy the DaxConnectorService folder from the zip file to the wwwroot folder.

This is usually found under C:\inetpub\wwwroot.
3. Copy the following files from the MS DAX Business Connector installation folder to the

DaxConnectorService\bin folder that you copied in the previous step.
The MS DAX Business Connector installation folder is commonly found in <Program Files>
\Microsoft Dynamics AX\60\BusinessConnector\Bin.
• Microsoft.Dynamics.AX.ManagedInterop.dll
• Microsoft.Dynamics.BusinessConnectorNet.dll

4. Open Internet Information Services (IIS) and add a new Website.
The Add Website window is displayed. Add the following information.

a. Add a Site name.
For example, Kta Connector or MSDax Connector.

b. Select an Application Pool.

c. In its Advanced Settings, ensure that the selected Application Pool has Enable 32-Bit
Applications set to True.

d. Set the Physical Path to the location where you saved the DAX connector. Refer to
Install Microsoft Dynamics AX ERP connector.

Important The selected application pool must have the necessary permissions to access the
specified physical path.

e. Set the Port as needed.
For example, 9810.

f. Ensure that Start Website immediately is selected.

g. Click OK.
The website is added to the Sites in the Connections pane.
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5. Select your new website and then double-click on Authentication from the central pane.
For the Authentication settings, set the following.

a. Ensure that Basic Authentication is set to Enabled.
If you cannot find the Basic Authentication option, make sure that this is enabled
in IIS following these instructions. https://docs.microsoft.com/en-us/iis/configuration/
system.webserver/security/authentication/basicauthentication.

b. Click OK.

Enable SSL

You can enable SSL by by following these steps.
1. In IIS, right-click on your web site and select Edit Bindings.

The Site Bindings window is displayed.
2. Click Add.

The Add Site Bindings window is displayed.
3. Set the Type to https.
4. Set the Port to an existing free port.
5. Set the SSL Certificate to any valid certificate.

You can use a self-signed certificate for testing purposes.
6. Click OK.

The Add Site Bindings window closes.
7. Click OK.

The Site Bindings window closes.

Test your installation

You can test your installation by following these steps.
1. Open the web.config file for your web site and set the KtaService:UseMockData setting to True.
2. In a web browser, go to http<s>://localhost:<port>/testconnection.

Make sure that the port and bindings match the values that you entered when you created the web
site or configured SSL.

3. Enter the username and password for any windows user.
A successful connection returns an XML ErrorCode of NONE.

Configure Dynamics AX 2012

Note This service must be installed on the same server where Dynamics AX 2012 Business Connector
is installed and correctly set up.

More information on the Business Connector is available from https://docs.microsoft.com/en-us/
dynamicsax-2012/developer/net-business-connector-overview.

The files mentioned in the steps below are included in the ERP Integration/MSDynamics/
KofaxConnector_For_DAX.zip/DaxConnectorIntegration folder that is provided alongside the
DAX Connector.
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You can configure Dynamics AX 2012 by following these steps.
1. Import the AX model by following these steps.

a. Close Microsoft Dynamics AX.

b. Extract the ERP Integration/MSDynamics/KofaxConnector_For_DAX.zip file.

c. Navigate to the DaxConnectorIntegration folder, right-click on the Import 2012
AXModel.bat file, and then select Run As Administrator.
The batch file executes.

d. Restart the Windows Service called Microsoft Dynamics AX Object Server
[version] - MicrosoftDynaticsAX.

e. Run Microsoft Dynamics AX.

f. When the application opens, and the message "The model store has been modified" is
displayed, click Skip and then OK.

g. Press Ctrl + D to open AOT and then click on the Project button.

h. To open the project, expand the Shared note and then double-click RpiIntegration.

i. From the Build menu, select Compile.
A progress bar indicates when the compilation is complete.

j. From the Build menu, select Generate Incremental CIL.
2. Configure Manual Imports by following these steps.

a. Go back to the AOT view and then press Import.

b. Browse to and select the ManualImports/Class_RpiGLService.xpo file.

c. Select Show details.
The class details in the Import form are displayed.

d. Click OK.

e. Browse to and select the ManualImports/Services.xpo file.

f. Select Show details.
The class details in the Import form are displayed.

g. Click OK.

h. From the Build menu, select Compile.
A progress bar indicates when compilation is complete.

i. From the Build menu, select Generate Incremental CIL.
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Configure the Dynamics AX ERP web service

You can configure the Microsoft Dynamics AX ERP web service by following these steps.
1. Open the web.config file and edit the following settings, all prefaced with KtaService.

a. KtaService:UseMockData. Using mock data affects data import. Data is imported from CSV
files located in the MockData folder instead of from the ERP.
Use this feature for testing purposes only.

b. KtaService:MockDataImportDelay. This is the mock data import delay in seconds. When
importing mock data, you can test data retrieval when import is still running.
However, mock data imports may be very fast, making it difficult to test. Because of this, it is
possible to specify a simulated delay time.
Use this feature for testing purposes only.

c. KtaService:NoOfPastImportsToKeep. Defines how many imports worth of data remain
stored in the database.
When set to 0, all past import data is cleared as soon as a new import is triggered. This is the
recommended value for this setting.
When set to 1, import data is never cleared from the database.

2. Open the web.config file located in <SiteRoot>\Services\Connectors\Dax\config.
This file is where you define certain company information.
For each Company placed under Companies, a journal name and GISegments are required with the
following settings.

a. Id is the ID of a company in Dynamics AX.

b. JournalName is the name of the Journal used when exporting NON-PO invoices. For example,
APInvoice.

c. GISegments defiles the association between Segment Names and Segment Numbers.
Here is an example for a single company.
<Company>
 <Id>usmf</Id>
 <GlSegments>
   <Segment>
  <Name>BusinessUnit</Name>
  <Number>2</Number>
   </Segment>
   <Segment>
  <Name>Department</Name>
  <Number>3</Number>
   </Segment>
   <Segment>
  <Name>CostCenter</Name>
  <Number>4</Number>
   </Segment>
   <Segment>
  <Name>ItemGroup</Name>
  <Number>5</Number>
   </Segment>
 </GlSegments>
 <JournalName>APInvoice</JournalName>
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</Company>

A default company must also be defined. This is the default configuration that is used for companies
that you have not explicitly configured.
Here is an example of a default company definition.
<Company>
   <Id>default</Id>
   <GlSegments>
  <Segment>
    <Name>BusinessUnit</Name>
    <Number>2</Number>
  </Segment>
  <Segment>
    <Name>Department</Name>
    <Number>3</Number>
  </Segment>
  <Segment>
    <Name>CostCenter</Name>
    <Number>4</Number>
  </Segment>
  <Segment>
    <Name>ItemGroup</Name>
    <Number>5</Number>
  </Segment>
   </GlSegments>
   <JournalName>APInvoice</JournalName>
</Company>

Final steps

You can finalize your Dynamics AX configuration by following these steps.
1. In the same web.config file that you used to configure your companies, the

system.serviceModel/client/endpoint nodes need updated to point to the correct DAX
instance.
You do this by updated the address attribute of the endpoint nodes. In the endpoint nodes the value
attribute of the servicePrincipalName nodes needs updated accordingly.

2. After setting up Dynamics AX, it is important to set KtaService:UseMocData to False.

Install Infor Lawson connector
If you have already installed the Infor Lawson ERP connector with Kofax Invoice Processing Agility, skip
this section.

If you are using the Infor Lawson ERP system, it is necessary to install this connector in addition to the
Agnostic ERP connector. You cannot install this connector without the Agnostic ERP connector.

Install the Infor Lawson ERP connector by following these steps.
1. Download the KofaxAPAgilityERPConnector-2.2.0_For_Lawson.ZIP from the Kofax Fulfillment Site

and extract it on a local drive available to your users.
2. Copy the contents in ERP Connector\bin from the extracted files to the bin folder in IIS where

the ERP connector files are stored.
By default, this path is <Program Files>\Kofax\APAgility\Web\bin.
The Infor Lawson connector is installed and ready for integration with Kofax AP Agility.
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Infor Lawson integration

To integrate Infor Lawson with Kofax AP Agility, follow these steps:
1. Create the ERP connection. Complete the information in the fields. The following settings are

required.
• In the Connection Type field, select Infor Lawson.
• In the Start Data Load From, a starting date is required.

2. Set up the organization to use the ERP connection.
3. Integrate the Infor Lawson with Kofax AP Agility by following these steps:

a. Verify that prerequisites for Infor Lawson integration are complete.

b. Create the Infor Lawson web service.

c. Configure the Infor Lawson web service.

d. Configure the Infor Lawson connection settings.

e. Review information about Infor Lawson data import and export configuration.

f. Configure the AGS invoice export (optional).

g. Adjust the Master data retrieval configuration (optional).

h. Review Lawson AGS invoice export mapping for the header.

i. Review Lawson AGS invoice export mapping for the lines.

Prerequisites for Lawson integration

Before you can configure the Lawson connector, the following prerequisites are necessary.

1. The user defined when you create the web service requires READ permissions for the following
Lawson tables.
• APVENLOC

• APINVOICE

• PORECLINE

• GLCHARTDTL

• APVENMAST

• TERMS

• APCOMPANY

• ACACTIVITY

• POLINE

• APPAYMENT

• GLSYSTEM

• ACACCTCAT

• PURCHORDER

• MAINVDTL

• GLNAMES
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2. The configured user also requires ADD, CHANGE, and DELETE access for the following screens.
• AP20.2
• MA43.1
• MA43.3

3. .NET 4.5.2 is required in order to use the Lawson connector.

Create Lawson web service

Before you can make use of the Lawson ERP Connector, it is necessary to create the web service using
the files provided.

You can create the Lawson web service by following these steps.
1. Install the Lawson ERP connector.

a. In the unzipped files, navigate to the ERP Integration\Lawson folder.
The KofaxConnector_For_Lawson.zip file appears.

b. Extract KofaxConnector_For_Lawson.zip.
You can provide your own folder name or use the default name provided during extraction.
The folder is extracted. Use this to copy the project.

c. Copy the extracted folder from the previous step to a location that is accessible by IIS.
For example, C:\inetpub\wwwroot.

2. Launch IIS.
3. In the Connections pane, expand http://localost represented by your computer name.

A list of Application Pools and Sites appears.
4. Select and then right-click on Sites. Select Add Website.

The Add Website window opens.
5. In the Add Website window, enter the following information.

a. In the Site name field, enter a name for your web service.
For example, KTA Lawson Connector.

b. For the Application Pool, click Select and then choose .NET v4.5 from the list.

c. In the Physical Path, click on the Browse button and navigate to and select the folder you
copied in step 1 b.

d. Configure the other settings as required.
For example, set the Binding Port to 9810.

e. Ensure that the Start Website immediately option is selected and then click OK.
The website is created and listed under Sites.

6. Select your newly created website.
The central Home pane is updated for your site.

7. In the central Home pane, under IIS, double-click on Authentication.
The Authentication settings are displayed.
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8. Ensure that Basic Authentication is enabled.
If necessary, right-click on Basic Authentication and select Enable.
If you cannot find Basic Authentication in your website, make sure that Basic Authentication is
enabled in IIS by following these instructions.
https://docs.microsoft.com/en-us/iis/configuration/system.webserver/security/authentication/
basicauthentication.
A warning message appears because you are not using an SSL.

9. Enable SSL for your website as follows.

a. In the Connections panel, right-click on your website and select Edit Bindings.
The Site Bindings window appears.

b. In the Site Bindings window, click Add.
The Add Site Binding window s displayed.

c. In the Add Site Binding window, specify the following.
Set Type to https.
• Set the Port to any available port.
• Set the SSL certificate to a valid certification.

d. Click OK.
Your newly added binding is listed on the Site Bindings window.

e. Click Close.
The Site Bindings window is closed.

Your website is now configured for SSL connections.
10. Test your installation as follows.

a. Edit the website Web.config file so that the KtaService:UseMockData setting is set to true.

b. In a web browser go to https://localhost:<port number>/testConection.
Where <port number> matches the port you specified in step 10 c.

c. When prompted, enter the Username and Password for any Windows user.
If the connection is successful, the following appears.
<?xml version="1.0"?>
<ConnectorTestStatus xmlns="http://schemas.datacontract.org/2004/07/
KtaConnector.Services" xmlns:i="http://www.w3.org/2001/XMLSchema-instance">
  <AdditionalInformation/>
  <ErrorCode>NONE</ErrorCode>
  <IsSucceeded>true</IsSucceeded>
  <Message/>
</ConnectorTestStatus>

If the testing fails, review the previous steps and try again.
Your web service website is ready for configuration.

Configure Lawson web service

Now that the web service is installed and its connection string is referenced in the web.config file, it is
necessary to configure the web service.
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You can configure the Lawson web service by following these steps..
1. Restart the Lawson web service that you recently created.
2. Navigate to the Lawson web service <serviceFolder>/Services/Connectors/Lawson/lib

folder and open the RPILawsonCOM_Config.xml file for editing.
3. In the RPILawsonCOM_Config.xml file, edit the following parameters.

Parameter Name Description and Examples

LawsonAuth The authentication method.
Choose between one of the following two authentication types.
• PREMISES - Enter this value if you are using Kofax AP Agility on-

premise.
• CLOUD - Enter this value if you are using Kofax AP Agility in an Azure

environment.

Username The username of the Lawson user used by the connector for
authentication.

Password The password of the Lawson user used by the connector for
authentication.

ProductLine The product line to use when querying Lawson.

LawsonDMEPath The relative path to the Lawson data servlet.
For example, "/servlet/Router/Data/Erp?".

LawsonAGSPath The relative path to the Lawson transaction servlet.
For example, "/servlet/Router/Transaction/Erp?".

LawsongWriteAttachPath The relative path to the Lawson writeAttach executable.
For example, "/cgi-lawson/writeattache.exe".

LawsonGetAttachPath The relative path to the Lawson getAttach execuatble.
For example, "/cgi-lawson/getattachrec.exe".

LawsonBaseURL The base URL where Lawson is listing for requests.
For example, https://100.11.12.13.

If you are using Kofax AP Agility in an Azure environment, also edit the following cloud-specific
parameters.

Parameter Name Description and Examples

LandmarkBaseURL The URL of the landmark instance that the Lawson connector uses for
authentication.

CloudAdfsUrl The URL that is used in the third step of the Lawson connector
authentication process.

CloudBaseUrl The URL that is used in the fourth step of the Lawson connector
authentication process.

4. Save and then Close the RPILawsonCOM_Config.xml file.
5. Open the web.config file for editing. This file was created when you created the web service.
6. Edit the web.config file so that the KtaService:UseMockData setting is set to false.

This ensures that the web service no longer uses mock data.
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7. Save and Close the web.config file.
Your Lawson web service is now ready for use.

Lawson data import and export configuration

The Lawson connector uses the Lawson Data Service (DME) to retrieve AP master data. It also uses the
Lawson Application Gateway Service (AGS) to export invoice data into Lawson. The DME queries are
defined in the RPILawsonCOM.config.xml file.

The AGS scripts are used to export NON-PO, credit, and PO-based invoices.

The DME queries and AGS calls are adjustable based on your requirements and how Lawson is
configured.

By default, import and export have a default configuration. However, you can adjust these settings as
needed for your installation.

Master data retrieval configuration

Lawson Data Service (DME) is a service that provides dynamic, read-only access to Lawson data. When
a user makes a request from the Lawson Portal or another location, DME makes calls to the database and
returns the requested data ensuring that the security rules are enforced. DME retrieves data and sends
it back to the requesting client. By default, the format of the data sent back is XML. However, this can be
modified to CSV format if necessary.

This data retrieval does not support data updating.

Note After a configuration change restart the Lawson web service for the change to take effect.

Data query configuration
File Location:  \Services\Connectors\Lawson\lib\RPILawsonCOM_config.xml
DME queries specified in the config file should not be edited in most cases. However, there are some
cases were it may be necessary to adjust the configuration. Specifically, it may be necessary to update
the SELECT clause in the DME query to filter results or add additional customer user fields that re
used. Existing data columns should not be removed. DME queries must be URL encoded in the XML
configuration file.
Vendors query example.
<item key="APVenMast">
   <Query QueryMode="Xml">
    <QueryURL>FILE=APVENMAST&amp;FIELD=VENDOR%2DSNAME;TAX%2DID;REMIT%2DTO
%2DCODE;VENDOR;VENDOR%2DGROUP;VENDOR%2DVNAME;VDR%2DADDR1;VDR%2DADDR2;VDR%2DCITY
%2DADDR5;VDR%2DCOUNTRY;VDR%2DPOSTAL;VDR%2DSTATE;VAT%2DREG%2DCTRY;VAT%2DREG%2DNBR;BANK
%2DID;VBANK%2DACCT%2DNO;E%2DMAIL%2DADDRESS;PHONE%2DNUM;VENDOR%2DCONTCT;BANK
%2DENTITY;VDR%2DADDR3;DISC%2DCALC%2DDATE;INV%2DCURRENCY;BANK%2DINST%2DCODE;CASH
%2DCODE;VAT%2DREG%2DCTRY;REQUIRE%2DPO;TERM%2DCODE;URL%2DADDR&amp;SELECT=VENDOR%2DGROUP
%3DVEN%7CVENDOR%2DGROUP%3D4321&amp;OUT=XML&amp;NEXT=TRUE&amp;{0}</QueryURL>
   </Query>
  </item>
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Adding data filtering to the DME queries
In the Vendors query example above we can see that there is filtering applied with a SELECT statement in
the query.
"SELECT=VENDOR%2DGROUP%3DVEN%7CVENDOR%2DGROUP%3D4321"

This is a URL encoded version for  "SELECT=VENDOR-GROUP=VEN|VENDOR-GROUP=4321".
For more information, see the Lawson Doc for Developers: IOS Application Program Interfaces.
Invoices query example.
<item key="APInvoice">
   <Query QueryMode="Xml">
    <QueryURL>FILE=APINVOICE&amp;FIELD=APPAYMENT%2ECHECK%2DDATE;APPAYMENT%2EVOID
%2DDATE;APPAYVENMAST%2EVENDOR%2DSNAME;APPAYVENMAST%2EREMIT%2DTO%2DCODE;OBJ
%2DID;VENDOR;COMPANY;INVOICE;CANCEL%2DDATE;INVOICE%2DDTE;INVOICE%2DTYPE;BASE%2DINV
%2DAMT;PO%2DNUMBER;REC%2DSTATUS;APPAYVENMAST%2EVENDOR;&amp;OUT=XML&amp;NEXT=TRUE&amp;
{0}</QueryURL>
   </Query>
  </item>

In the Invoices query above there is no SELECT clause. This means that for the specific Lawson instance,
no filtering is required. A SELECT clause can be added if necessary.

AGS invoice export configuration

The AGS Export uses the XSLT 1.0 transform the incoming XML from Kofax into a set of transactions
required to process invoices in Lawson. See Lawson AGS export mapping - Invoice Header fields and
Lawson AGS export mapping - Invoice Line fields for additional mapping details.

Note After a configuration change restart the Lawson web service for the change to take effect.

NON-PO/CREDIT Transaction
File Location: \Services\Connectors\Lawson\lib\Invoice_Add_NonPO.xslt.
Example 1.
<API-INVOICE>
      <xsl:value-of select="translate(InvoiceNumber,'abcdefghijklmnopqrstuvwxyz',
'ABCDEFGHIJKLMNOPQRSTUVWXYZ')"/>
     </API-INVOICE>

Example 2.
<API-INVOICE-TYPE>
      <xsl:if test="DocumentType = 'CREDIT'">C</xsl:if>
      <xsl:if test="DocumentType != 'CREDIT'"></xsl:if>
     </API-INVOICE-TYPE>

PO Match Transaction
File Location: \Services\Connectors\Lawson\lib\Invoice_Add_PO.xslt.
Example 1.
<PT-MAD-LINE-NBR><xsl:value-of select="substring-after(GrDocNo,'-')"/></PT-MAD-LINE-
NBR>

Example 2.
<MAD-ENTERED-QTYr0><xsl:value-of select="Quantity"/></MAD-ENTERED-QTYr0>

Lawson AGS export mapping - Invoice Header fields
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The following table explains the invoice header export fields used by the Lawson AGS.

Tag Description Lawson API
Field

Interface
Notes

Invoice The root XML tag.

Invoice/AccountNumber The account number field has a unique
identification number for an organization from
the vendor point-of-view. See the Help for Kofax
AP Agility Settings for additional information.

N/A N/A

Invoice/AlternatePayee This field is a supplementary field to the Vendor
ID. It represents the party that receives invoice
payments, and is not necessarily the vendor
listed on the invoice. This payee must be on
a list of pre-defined permitted payees for the
extracted Vendor. See the Help for Kofax AP
Agility Settings for additional information.

N/A Lawson
Handles
"Payment
Vendor"
in internal
setup and not
during Invoice
Creation

Invoice/AlternatePayeeAddress Not used for export in ERP. N/A N/A

Invoice/AmtMiscellaneous Not used for export in ERP. N/A N/A

Invoice/AmtWithholdingTax The withholding tax amount fields capture the
portion of the invoice total that is withheld by an
organization for legal reasons and not paid back
to the vendor.

N/A N/A

Invoice/AmtPst This field captures the Provincial Sales Tax
(ProvincialSalesTax/QST) component of
Canadian tax.

N/A N/A

Invoice/ApproveTime Time when the invoice has been approved in
Kofax AP Agility.

N/A N/A

Invoice/ApproverName Approver name who approved the invoice in
Kofax AP Agility.

N/A N/A

Invoice/BankAccount The bank account number captures where the
vendor wants to be paid.

N/A Handled
in Lawson
Vendor Setup
not during
Invoice
Creation

Invoice/BankAccountCode The bank account code represents the
identification of the bank account for that vendor
from the point-of-view of the downstream ERP
system.

N/A Handled
in Lawson
Vendor Setup
not during
Invoice
Creation

Invoice/BIC The BIC or SWIFT code is an internationally
assigned code to identify a unique banking
institution.

N/A N/A
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Tag Description Lawson API
Field

Interface
Notes

Invoice/BillToName This field represents the name of the invoice
recipient. This field is used to check that the
incoming document is intended for a valid
company within an organization.

N/A N/A

Invoice/BillToVatRegNo The Vendor VAT Registration Number and Bill-to
VAT Registration Number are available to satisfy
a European legal/fiscal compliance ruling. This
law states that if value added tax is charged, the
vendor must state their VAT registration number
as well as the VAT registration number of the bill-
to party on the invoice.

N/A N/A

Invoice/BusinessUnitID ID of the invoiced business unit. API-
COMPANY

REQUIRED

Invoice/Currency This field contains the ISO-code of the invoice
currency. (USD, GBP, EUR, etc.)

API-INV-
CURRENCY

Invoice/Custom1 Not used for export in ERP. N/A

Invoice/Custom2 Not used for export in ERP. N/A

Invoice/Custom3 Not used for export in ERP. N/A

Invoice/Custom4 Not used for export in ERP. N/A

Invoice/Custom5 Not used for export in ERP. N/A

Invoice/DeliveryDate This field captures the delivery date for the
goods or services stated on the invoice.

N/A

Invoice/DeliveryNote This field captures the vendor delivery note
number if one is found on the invoice.

N/A

Invoice/Discount This field captures a discount given by the
vendor. See the Help for Kofax AP Agility
Settings for additional information.

N/A Driven by
Payment terms
Code logic

Invoice/DiscountDueDate Not used for export in ERP. N/A

Invoice/DocumentType INVOICE, CREDIT. This field indicates if the
incoming document is an invoice or a credit
memo.

API-INVOICE-
TYPE

Logic in export
mapping
to set this
value to "C" if
DocumentType
= "CREDIT"
Other wise
Blank (Invoice)
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Tag Description Lawson API
Field

Interface
Notes

Invoice/DueDate This field captures the due date for payment. API-DUE-
DATE

If the vendor or
location does
not have a
payment terms
code assigned
and you do
not assign
a payment
terms code to
the invoice,
this field is
required

Invoice/EmployeeID This field contains the identification number for
the user name of an employee found on the
document. This field can be used downstream
in the workflow to route the document to the
relevant person in your organization. For
example, for invoice coding and approval.

N/A N/A

Invoice/EmployeeIndexNumber Not used for export in ERP. N/A N/A

Invoice/EmployeeName This field contains the user name of an
employee found on the document. This field can
be used downstream in the workflow to route
the document to the relevant person in your
organization. For example, for invoice coding
and approval.

N/A N/A

Invoice/ExchangeRate Not used for export in ERP. N/A N/A

Invoice/Freight This field captures a freight charge specified
by the vendor at the header level. Freight is
typically captured at the line-item level.

N/A Mapped at the
Line Level

Invoice/HarmonizedSalesTax This is a type of sales tax (HarmonisedSalesTax)
adopted by many Canadian provinces
that combine the traditional Goods and
Services Tax (GST) and Provincial Sales Tax
(ProvincialSalesTax) into a single tax amount.

N/A N/A

Invoice/Iban This number represents the international bank
account number invoice payment. It is extracted
by the system in partnership with the BIC code.

N/A N/A

Invoice/Icms ICMS tax is a form of sales tax that is applied
to material items in Brazil. When extracted, the
system converts this to a valid amount using
a period as the decimal separator. See the
Help for Kofax AP Agility Settings for additional
information.

N/ A N/A

Invoice/InvalidReason Not used for export in ERP. N/A N/A

Invoice/InvoiceDate Invoice date API-DISTRIB-
DATE

API-DISTRIB-
DATE
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Tag Description Lawson API
Field

Interface
Notes

Invoice/InvoiceNumber The invoice number is a unique identifier for a
document, from the point-of-view of the supplier.

API-INVOICE

Invoice/InvoiceType PO, NON-PO. This field indicates if an invoice is
a purchase order (PO) or a non-purchase order
(NON-PO).

N/A N/A

Invoice/IpaClientName Not used for export in ERP. N/A N/A

Invoice/IsrRetention The ISR Retention (Impuestos sobre la Renta)
field is used to capture the ISR retention
component to withhold tax. This field can
appear on Mexican invoices. The IVA retention
component is captured in the regular withholding
tax field.

N/A N/A

Invoice/LocalVatAmount Not used for export in ERP. N/A N/A

Invoice/MexicanUuid This field is an invoice number that is provided
by the Mexican SAT authorities. It appears as
a standard field on electronic documents. It is
36 characters long and must be captured for
government reporting purposes.

N/A N/A

Invoice/NetAmount0 This field contains the extracted amounts on the
document that have a tax rate of zero.

N/A N/A

Invoice/NetAmount1 This field captures an invoice subtotal amount
and it forms part of the Invoice Total. See the
Help for Kofax AP Agility Settings for additional
information.

N/A N/A

Invoice/NetAmount2 These fields contain the extracted amounts
on the document that have tax rates specified
in TaxRate2-TaxRate4 fields. See the Help
for Kofax AP Agility Settings for additional
information.

N/A N/A

Invoice/NetAmount3 N/A N/A

Invoice/NetAmount4 N/A N/A

Invoice/OrganizationName The name of the invoiced organization in ERP N/A N/A

Invoice/OrganizationId ID of the invoiced organization in ERP N/A N/A

Invoice/PaymentReference This field captures vendor payment references
specified on an invoice.

N/A N/A

Invoice/PoExtension The PO Extension field is populated in
implementations involving JD Edwards
or PeopleSoft only. In JD Edwards
implementations, this field contains the purchase
order type. In PeopleSoft implementations, this
field contains the purchasing business unit.

N/A N/A

Invoice/PoNumber Purchase order number. Valid only for PO
invoices.

API-PO-
NUMBER

N/A
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Tag Description Lawson API
Field

Interface
Notes

Invoice/PorNumber The payment order reference (POR) number
is a 27-character transaction ID applied to the
invoice by the Swiss Postal Service. See the
Help for Kofax AP Agility Settings for additional
information.

N/A N/A

Invoice/PorSubscriberNo The payment order reference (POR) subscriber
number. See the Help for Kofax AP Agility
Settings for additional information.

N/A N/A

Invoice/PoType MATERIAL, SERVICE. This field indicates if an
extracted purchase order relates to materials
or services. See the Help for Kofax AP Agility
Settings for additional information.

N/A Static Value
Used to
determine the
type of Export.
Not Mapped

Invoice/SiteID Vendor site ID. API-REMIT-
TO-CODE

N/A

Invoice/TaxAmount1 These fields contain the tax amounts for their
corresponding Net Amounts. See the Help
for Kofax AP Agility Settings for additional
information.

API-TRAN-
TAX-AMT

N/A

Invoice/TaxAmount2 N/A N/A

Invoice/TaxAmount3 N/A N/A

Invoice/TaxAmount4 N/A N/A

Invoice/TaxRate1 These fields contain the tax rates for their
corresponding Net Amounts. See the Help
for Kofax AP Agility Settings for additional
information.

N/A N/A

Invoice/TaxRate2 N/A N/A

Invoice/TaxRate3 N/A N/A

Invoice/TaxRate4 N/A N/A

Invoice/InvoiceAmount This field contains the total amount due for
payment on the current invoice.

API-TRAN-
INV-AMT

REQUIRED

Invoice/VendorCity Not used for export in ERP. N/A N/A

Invoice/VendorId Vendor ID API-VENDOR REQUIRED

Invoice/VendorIndexId Not used for export in ERP. N/A N/A

Invoice/VendorName1 Not used for export in ERP. N/A N/A

Invoice/VendorStreet1 Not used for export in ERP. N/A N/A

Invoice/VendorStreet2 Not used for export in ERP. N/A N/A

Invoice/VendorVat Not used for export in ERP. N/A N/A
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Tag Description Lawson API
Field

Interface
Notes

Invoice/VendorVatRegNo The Vendor VAT Registration Number and Bill-to
VAT Registration Number are available to satisfy
a European legal/fiscal compliance ruling. This
law states that if value added tax is charged, the
vendor must state their VAT registration number
as well as the VAT registration number of the bill-
to party on the invoice.

N/A N/A

Invoice/VendorZip Vendor ZIP code N/A N/A

Invoice/YourRef Use this field to capture a reference number
specified on the invoice that relates to the
billable party. It can often consist of a contact
name, a reference number, or a combination of
both.

N/A N/A

Invoice/PasswordCn This field is used for domestic VAT invoices on
Mainland China and refers to the encrypted 4-
line coding block that appears in the top-right
hand quadrant of the invoice document.

N/A N/A

Invoice/InvoiceCodeCn This field is used for domestic VAT invoices on
Mainland China. It refers to the ten digit numeric
code that habitually appears in the top-left hand
corner of the document.

N/A N/A

Invoice/EcmDocumentId Document ID in the enterprise content
management system where the document has
been exported to (for ECM integration).

N/A Would be
custom
mapped
for each
implementation

Invoice/DocumentLink Document ID in ECM where the invoice was
exported to by Kofax AP Agility.

N/A Would be
custom
mapped
for each
implementation

Invoice/ErpPoType Not used for export in ERP. N/A N/A

Invoice/ScanDate Invoice import (or scan) time. N/A N/A

Invoice/SubTotal Not used for export in ERP. N/A N/A

Invoice/Urn Unique archive document ID (for early archiving
scenarios).

N/A N/A

Invoice/IpaInvalidReasonCode Not used for export in ERP. N/A N/A

Invoice/IpaInvalidReasonRule Not used for export in ERP. N/A N/A

Invoice/IpaOrganizationName Not used for export in ERP. N/A N/A

Invoice/IpaOrganizationId Not used for export in ERP. N/A N/A

Invoice/PaymentComments Not used for export in ERP. N/A N/A

51



Kofax AP Agility Installation Guide

Tag Description Lawson API
Field

Interface
Notes

Invoice/PaymentMethod Payment method. N/A Defaulted
by Vendor in
Lawson

Invoice/ImageExtension Invoice image file name extension (depends on
the image type, for example, .tiff, .pdf, etc.)

N/A Documents
are not
exported to
Lawson

Invoice/ImageBase64 Base64 encoded invoice image N/A Documents
are not
exported to
Lawson

Lawson AGS export mapping - Invoice Line fields

The following table explains the invoice line export fields used by the Lawson AGS.

Tag Description Lawson API
Field

Interface
Notes

Invoice/LineItem Root for a line item Lawson API
Field

Interface
Notes

Invoice/LineItem/Category Miscellaneous charge category applied to the
invoice line item based on the extracted line item
description.

N/A N/A

Invoice/LineItem/Description Invoice line item description. If the line item is
paired, this description appears on the purchase
order. If the line is unpaired, this field contains
the raw text description that was read from the
invoice. For third-party freight invoices, service
invoices, and MIRA invoices where no line
items were required in the TAB section, and line
pairing was either unsuccessful for any lines,
or was not carried out, the description is set to
THIRD PARTY FREIGHT, SERVICE and MIRA
respectively.

N/A N/A

Invoice/LineItem/Discount Not used for export in ERP. N/A N/A

Invoice/LineItem/LineNumber Line number (1..N) MAD-LINE-
NBRr0

Each line is
added to the
first Row
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Tag Description Lawson API
Field

Interface
Notes

Invoice/LineItem/LineType One of: Item, Sales Tax, Misc. Tax, Freight,
Misc. Charge. See IpaLineType below

N/A Not mapped,
but when used
would drive
different logic
for the line
depending on
the Type of
Line..MISC
add on cost vs
SPREAD add
on cost vs TAX

Invoice/LineItem/
MeterialNumber

Invoice line item material number. If the line
item is paired, this is populated with the material
number from the purchase order line item. If
the line is not paired, this is populated with any
values read from the invoice.

N/A N/A

Invoice/LineItem/
OriginalLineNumber

Not used for export in ERP. N/A N/A

Invoice/LineItem/PoNumber The purchase order number, and is populated
only if line pairing is successful for this item.

AOI-PO-
NUMBER

N/A

Invoice/LineItem/Quantity The invoice line item quantity. MAD-
ENTERED-
QTYr0

Each line is
added to the
first Row -
Only used in
PO

Invoice/LineItem/Total The invoice line item total. N/A Not mapped -
calculated in
Lawson based
on unit price X
quantity

Invoice/LineItem/UnitPrice The invoice line item unit price and it is only
populated for unpaired line items. In all other
cases, it has a value of zero.

MAD-ENT-
UNIT-CSTr0

Only used on
PO invoices

Invoice/LineItem/
UnitOfMeasure

Unit of measure. ENT-BUY-
UOM

N/A

Invoice/LineItem/UnitOfQuantity Unit of quantity. N/A N/A

Invoice/LineItem/TaxAmount Tax amount MISC-INV-
AOC-AMTr0

Used in
Conjunction
with an add on
cost code - PO
Invoice Only

Invoice/LineItem/TaxRate Tax rate Invoice line item tax rate. The
percentage rate of tax applied to the invoice line
item. If no percentage tax rate at line item level
can be ascertained, then this value is blank.

N/A N/A
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Tag Description Lawson API
Field

Interface
Notes

Invoice/LineItem/ChargeCode Invoice line item charge code. This is lifted from
the purchase order line item to which an invoice
line is paired.

N/A N/A

Invoice/LineItem/ChargeCodeId Invoice line item charge code ID (only for PO-
matched lines). This is lifted from the purchase
order line item to which an invoice line is paired.

N/A N/A

Invoice/LineItem/
CompanyCode

Company code that corresponds to a line item.
This is lifted from the purchase order when an
invoice line is paired.

N/A N/A

Invoice/LineItem/ErpPoType Not used for export in ERP. N/A N/A

Invoice/LineItem/MaterialGroup This column represents the material group of the
purchase order line item material. If available,
it can be mapped simply to pass this data to a
downstream ERP for a paired line item.

N/A N/A

Invoice/LineItem/Plant Plant ID. This is lifted from the purchase order
line item with which an invoice line is paired.

N/A N/A

Invoice/LineItem/
PoLineNumber

The purchase order line item number. It
is populated only if line pairing has been
successful for this item.

MAD-LINE-
NBRr0

N/A

Invoice/LineItem/Puom The order unit of measure and it is populated
with the purchase order line item order unit
measure if the line item has been paired.

N/A N/A

Invoice/LineItem/QtyPuom The quantity in the order price unit of meausre.
This value is calculated during line pairing if
UOM does not correspont to PUOM.

N/A N/A

Invoice/LineItem/
TaxableAmount

Taxable amount APD-
TAXABLE-
AMT

Only mapped
on non-po
Invoices

Invoice/LineItem/TaxCode The invoice line item tax code, and it is
populated using the tax determination procedure
if a line item is paired.

APD-TAX-
CODE

Only mapped
on non-po
Invoices

Invoice/LineItem/Activity Not used for export in ERP. Copied from
accounting data that was retrieved from ERP.
Obviously SAP only so far.

N/A Mapped in
GLSegments

Invoice/LineItem/BusinessArea Not used for export in ERP. Copied from
accounting data that was retrieved from ERP.
Obviously SAP only so far.

N/A Mapped in
GLSegments

Invoice/LineItem/CostCenter Not used for export in ERP. Copied from
accounting data that was retrieved from ERP.
Obviously SAP only so far.

N/A Mapped in
GLSegments
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Tag Description Lawson API
Field

Interface
Notes

Invoice/LineItem/DbCrIndicator The subsequent debit or credit indicator that
indicates is the line item is a subsequent debit of
a credit line item. If this value is set to X and the
document type is INVOICE, then the line item is
treated as a subsequent debit, the amount only
and not the quantity. If the value is set to X and
the document type is CREDIT then the line item
is treated as a subsequent credit. If the value
is blank the line item is treated as a regular line
item.

N/A N/A

Invoice/LineItem/InternalOrder Not used for export in ERP. Copied from
accounting data that was retrieved from ERP.
Obviously SAP only so far.

N/A N/A

Invoice/LineItem/Network Not used for export in ERP. Copied from
accounting data that was retrieved from ERP.
Obviously SAP only so far.

N/A N/A

Invoice/LineItem/ProfitCenter Not used for export in ERP. Copied from
accounting data that was retrieved from ERP.
Obviously SAP only so far.

N/A N/A

Invoice/LineItem/SalesOrder Not used for export in ERP. Copied from
accounting data that was retrieved from ERP.
Obviously SAP only so far.

N/A N/A

Invoice/LineItem/
SalesOrderItem

Not used for export in ERP. Copied from
accounting data that was retrieved from ERP.
Obviously SAP only so far.

N/A N/A

Invoice/LineItem/TaxJurCode The invoice line tax jurisdiction code. It
represents the downstream ERP system ID for
the tax office where taxes are paid for this line
item. This is used in countries that have tax
jurisdictions for their sales tax. It is populated
only if the line item is paired.

N/A N/A

Invoice/LineItem/WbsElement Not used for export in ERP. Copied from
accounting data that was retrieved from ERP.
Obviously SAP only so far.

N/A N/A

Invoice/LineItem/GlAccount GL account string specified in AP Agility
workflow Coding activity.

N/A N/A

55



Kofax AP Agility Installation Guide

Tag Description Lawson API
Field

Interface
Notes

Invoice/LineItem/GlSegment The value of one GL segment in GL account.
This tag may repeat for the invoice line. The
number of the segments should be equal to the
number of segments specified for the account
(in GlAccount tag). Each GlSegment tag should
have two attributes:

1. segmentNumber - the number of the
segment in the account structure (as
specified in Kofax AP Agility > Settings >
GL Account Structures for the segment
structure.

1. name - the segment name as specified for
this segment in GL structure CSV

Example: 
<GlAccount>01-000-1100-0000-000<GlAccount>
<GlSegment segmentNumber="1"
name="Organization">01<GlSegment>
<GlSegment segmentNumber="2"
name="Department">000<GlSegment>
<GlSEgment segmentNumber="3"
name="Account">1100<GlSegment>
<GlSegment segmentNumber="4"
name="SubAccount">0000<GlSegment>
<GlSegment segmentNumber="5"
name="Project">000<GlSegment>

NON-PO/
Credit
Invoices :
APD-DIST-
COMPANYr0
APD-DIS-
ACCT-UNITr0
APD-DIS-
ACCOUNTr0
APD-DIS-
SUB-ACCTr0
ADD-ON-
COST: API-
COMPANY
MISC-ACCT-
UNITr0 MISC-
ACCOUNTr0
MISC-SUB-
ACCTr0 PO-
Invoices: N/A

Based on
the line type
different logic
is used to map
fields

Invoice/LineItem/
ConditionCount

Not used for export in ERP. SAP only - refers to
planned conditions

N/A N/A

Invoice/LineItem/
ConditionStepNo

Not used for export in ERP. SAP only - refers to
planned conditions

N/A N/A

Invoice/LineItem/ConditionType Not used for export in ERP. SAP only - refers to
planned conditions

N/A N/A

Invoice/LineItem/FreightVendor Not used for export in ERP. SAP only - also
related to planned conditions

N/A N/A

Invoice/LineItem/GrDocItem The receipt line item number. It is populated only
if 3-way line pairing has been successful for this
item.

N/A N/A

Invoice/LineItem/GrDocNo The receipt number, and is populated only if 3-
way line pairing is successful for this item.

N/A N/A

Invoice/LineItem/GrDocYear Not used for export in ERP. N/A N/A

Invoice/LineItem/SheetItem Not used for export in ERP. N/A N/A

Invoice/LineItem/SheetNo Not used for export in ERP. N/A N/A

Invoice/LineItem/
IpaBusinessUnit

PeopleSoft business unit, copied over from PO
line.

N/A N/A
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Tag Description Lawson API
Field

Interface
Notes

Invoice/LineItem/IpaLineType Invoice line item type populated by Invoice
processing (see the Line Type field above). This
is lifted from the purchase order line item to
which an invoice line is paired.

N/A N/A

Agnostic ERP configuration
If you used the Full installation or selected to install the Agnostic Install ERP Connector Web Service
during the custom installation, configure the following in order to use this ERP system in production.
• Windows authentication for Agnostic ERP

For more information on configuring the Agnostic ERP and how it is used in Kofax AP Agility, refer to the
Help for Kofax AP Agility Settings.

Windows authentication for Agnostic ERP

If you are using Windows authentication, it is necessary to change the authentication type for your
Agnostic ERP web service.

You can enable Windows authentication for your Agnostic ERP connection by following these steps.
1. Open IIS.
2. Navigate to and click on your ApAgilityErpConnector web site.

A list of icons appears in the central panel.
3. Under the IIS group, double-click Authentication.

The Authentication page is displayed.
4. Click Windows Authentication

The Actions panel to the right is updated with options for this setting.
5. In the Actions panel, click Enable.

The Windows Authentication status is updated in the central panel.
6. Close IIS.

Windows authentication is now configured for the Agnostic ERP connector.

ERP master data import
The ERP master data in the Kofax AP Agility database must be updated regularly. For the Agnostic ERP,
data is imported from CSV files. For other connections, data is imported from the ERP application.

For the Agnostic ERP, you can configure a path to the file system folder where the data in CSV files live.
The files must be in the appropriate CSV format for the data you are importing.

To import the ERP master data, use the AP Data Import job. The Kofax AP Agility Administrator sets up
the schedule for the job or starts the job manually. One job imports data for all organizations.

Kofax AP Agility makes records about the status of the import jobs in these Kofax AP Agility database
tables:
• ERP_CONNECTOR_SERVICE_CALL_STATUS: Contains the status of each ERP Connector call.
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• ERP_IMPORT_JOB_STATUS: Contains the status of loading data as it is prepared by the ERP
Connector to the Kofax AP Agility database.

Use these records for troubleshooting purposes if the import fails or not all data was loaded.

The ERP master data includes the following types of data with the corresponding Kofax AP Agility
database tables:
• ERP invoices: ERP_INVOICE
• Payment terms: PAYMENT_TERM
• Payment terms details: PAYMENT_TERM_DETAIL
• Vendors: VENDOR_MASTER_DATA
• PO headers: PO_HEADER
• PO lines: PO_LINES
• GL Segments: GL_SEGMENTS
• Plants: PLANTS
• Receipt lines: RECEIPT_LINES
• Tax Codes: TaxCode
• Miscellaneous Charge: MiscChargesAccount
• Unit of Measure Conversions: BRWUOMConversions
• Employee: BRWEmployeeMaster

The data for all ERP master data types is located in the corresponding CSV files. Data types and formats
are as follows:
• Number: Standard number format
• Integer: Standard integer number format
• Double: Double number format with floating decimal
• String: Commas in the text must be in quotation marks
• Datetime: yyyy-mm-dd HH:MM:SS
• Bit: 0 or 1

CSV exchange format

In CSV format, place the fields in the order specified in this section. This format must contain a header,
and fields must be separated by a comma.

ERP invoices CSV format

Table name: ERP_INVOICE

File name (for Agnostic ERP): erp_invoices.csv

Field Index Type Description

1 String Invoice ID in ERP

2 String Business unit ID in ERP

3 String Invoice number

4 Datetime Invoice date

58



Kofax AP Agility Installation Guide

Field Index Type Description

5 String Invoice type:
• PO (for single PO invoices)
• NON-PO
• Credit Memo Invoice

6 Number Invoice amount

7 String PO Number (or Purchase Order Number)

8 Datetime Payment date

9 Datetime Canceled date

10 String Invoice payment status (PAID or UNPAID)

11 String Vendor Name

12 String Vendor site code

13 String Vendor site ID

14 String ERP vendor ID

For example, the contents of the erp_invoices.csv file may look as follows:

ERP_INVOICE_ID, ERP_BUSINESS_UNIT_ID, INVOICE_NUMBER, INVOICE_DATE, INVOICE_TYPE,
 INVOICE_AMOUNT, PO_NUMBER, PAYMENT_DATE, CANCELLED_DATE, INVOICE_STATUS, VENDOR_NAME1,
 VENDOR_SITE_CODE, VENDOR_SITE_ID, ERP_VENDOR_ID
214303,204,nd03np_KTM_05/31/2017,2017-05-31 00:00:00,Non-PO Invoice,1000,,,,UNPAID,GE
 Capital,BOSTON,289,93
214304,204,nd04np_KTM_05/31/2017,2017-05-31 00:00:00,Non-PO Invoice,1000,,,,UNPAID,GE
 Capital,BOSTON,289,94
214302,204,nd02np_KTM_05/31/2017,2017-05-31 00:00:00,Non-PO Invoice,1000,,,,UNPAID,GE
 Capital,BOSTON,289,95

Payment terms CSV format

Table name: PAYMENT_TERM

File name (for Agnostic ERP): payment_terms.csv

Field Index Type Description

1 String Payment term ID in ERP

2 String Business unit ID in ERP

3 String Payment term name

4 String Payment term description

For example, the contents of the payment_term.csv file may look as follows:

ERP_TERM_ID, ERP_BUSINESS_UNIT_ID, TERM_NAME, TERM_DESCRIPTION
10000,204,Prepayment Immediate,Seeded immediate terms for prepayments - do not update
10001,204,Immediate,Scheduled for payment immediately

Payment terms details CSV format

Table name: PAYMENT_TERM_DETAIL
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File name (for Agnostic ERP): payment_term_details.csv

Field Index Type Description

1 String Payment term detail ID in ERP

2 String Business unit ID in ERP

3 Number Payment sequence number

4 Number Percentage of invoice amount that must be paid before the invoice
due date

5 Number Amount that must be paid before the invoice due date. One of the
fields DUE_PERCENT or DUE_AMOUNT must be left blank

6 Number Days left before the invoice due date

7 Number Day of the month in the invoice due date

8 Number Months left for the invoice to be paid

9 Number Percentage of the discount

10 Number Days left before the discount due date

11 Number Day of the month before the discount due date

12 Number Months before the discount due date

Vendors CSV format

Table name: VENDOR_MASTER_DATA

File name (for Agnostic ERP): vendors.csv

Field Index Type Description

1 String The unique vendor ID from the extracted data. Each row must have
a unique reference. This is not the unique vendor ID from the ERP
system if a site ID is also used.

2 String Business unit ID in the ERP (company code).

3 String Default ERP payment terms ID for the vendor. It should match the
payment terms in Payment Terms CSV.

4 String Description.

5 String Vendor name.

6 String Vendor site ID. It should be empty if the ERP does not support the
vendor sites.

7 String Vendor site code. It should be empty if the ERP does not support the
vendor sites.

8 String Vendor street address line 1.

9 String Vendor street address line 2.

10 String Vendor city.

11 String Vendor zip code or postal code.
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Field Index Type Description

12 String Vendor state. For U.S. addresses, the state code is expected here,
such as CA = California, VA = Virginia.

13 String Vendor country. This is a two character ISO-code for the country,
such as US = United States of America, DE = Germany, GB = United
Kingdom.

14 String Vendor VAT code.

15 String Vendor VAT registration number. If the vendor is registered for VAT
in more than one country, then multiple VAT registration numbers are
provided in the form of a comma-separated list and the entire column
value should be quoted to preserve CSV format.

16 String Tax number.

17 String Bank code. This is the U.S. equivalent of a routing number.

18 String Bank account number.

19 String Email.

20 String URL.

21 String Vendor telephone number.

22 String Fax.

23 String Contact name.

24 Bit Is active.

25 Bit Is enabled.

26 String Term date basis:
• Invoice.
• Goods received.
• Current.
• Invoice received.

27 String Vendor Post Office (PO) box number.

28 String ZIP or postal code associated with the vendor Post Office (PO) box.

29 Bit The boolean indicator that denotes whether the vendor belongs to an
EU member state country.

30 String Vendor currency.

31 String Vendor tax ID 1.

32 String Vendor tax ID 2.

33 String ID of the tax office where the vendor is based.

34 String Vendor invoice type. This is set to a value that denotes either PO-
supplying vendor or vendor that submit invoices that legitimately do
not reference the purchase order. The value should be:
• FI: If the vendor can send non-PO invoices.
• MM: Vendor is able to send only PO invoices.
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Field Index Type Description

35 String The comma-separated list of payment method codes appropriate
for the vendor. If more than one code is specified then entire column
value to be quoted to preserve CSV format.

36 String Leave this value empty.

37 String The comma-separated list of company codes that are valid for the
vendor. If more than one code is specified then entire column value
to be quoted to preserve CSV format.

38 Bit Indicates whether the vendor is a utility vendor

39 String Vendor POR subscriber number used only for Switzerland.

40 String External site ID.

41 String ERP system vendor account group.

42 String Party that receives payment for an invoice.

43 String Leave this value empty.

44 String The vendor SIRET ID. This ID code used in France that uniquely
identifies a single vendor at a single address. It is often found on
French invoices.

45 String The unique vendor identifier code, such as a Chinese tax number.

46 String Indicates whether a vendor is or is not an Intercompany vendor.

47 String Vendor bank account code as specified in ERP.

PO headers CSV format

Table name: PO_HEADER

File name (for Agnostic ERP): po_headers.csv

Field Index Type Description

1 String PO header ID in ERP

2 String Business unit ID in ERP

3 String PO number

4 String PO type:
• MATERIAL
• SERVICE

5 String Vendor ID in ERP

6 String Vendor name

7 String Vendor site ID

8 String Vendor site code

9 String PO Status

10 Bit Is Active
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PO lines CSV format

Table name: PO_LINES

File name (for Agnostic ERP): po_lines.csv

Field Index Type Description

1 String PO line ID in ERP

2 String Business unit ID in ERP

3 String PO header ID in ERP

4 String PO number

5 Number Line number

6 String Material number

7 String Material group

8 String Description

9 Number PO Quantity

10 Number Unit price

11 Number PO total

12 String Tax code

13 String Tax jurisdiction code

14 String Unit of measure

15 Number Price unit

16 String PUOM (Order price unit of measure)

17 Number Total quantity delivered

18 Number Total value delivered

19 Number Total quantity invoiced

20 Number Total value invoiced

21 String Item category or line item type

22 String Plant (The location code for the ship-to address where the goods
were delivered, or where a service was performed)

23 String Charge code

24 String Charge code ID

25 String ERP PO type (for JD Edwards PO)

26 String ERS flag

27 Bit Receipt required

GL segments CSV format

Table name: GL_SEGMENTS

63



Kofax AP Agility Installation Guide

File name (for Agnostic ERP): gl_segments.csv

Field Index Type Description

1 String GL Segment ID in ERP

2 String Business unit ID in ERP

3 Integer GL Segment Number

4 String GL Segment Value

5 String Description

6 String GL Segment Name

Plants CSV format

Table name: PLANTS

File name (for Agnostic ERP): plants.csv

Field Index Type Description

1 String Plant ID. It must be unique in CSV. It matches Plant field specified for
PO lines. It is exported as the invoice line Plant field.

2 String Organization ID the plant belongs to. If an organization ID is not
provided, the plant is created and linked to the same organization to
which the ERP Connection belongs.

3 String Two character ISO country code for the plant. Entries with empty
country code are skipped in the import process.

4 String State where the plant is located. For the United States, use the two-
character state code such as CA for California.

Receipt Lines data format

Table name: RECEIPT_LINES

File name (for Agnostic ERP): receipt_lines.csv

Field Index Type Description

1 String Business unit ID in ERP (company code).

2 String PO number, which is used during line pairing to match the receipt
line to the number of PO. (See PO lines CSV format.)

3 String ERP PO line number. This is an ERP-specific line ID in the PO, such
as the line number. It must be unique among lines in the PO. It is
used during line pairing to match the receipt line to the number of PO
line. (See PO lines CSV format.)

4 String ERP receipt ID. It is used by Invoice Processing Agility as the receipt
number (DOC_NO field) during line pairing. For the line paired
invoice lines, it is exported as GRDocNo tag.

5 String ERP receipt item number. It is used by Invoice Processing Agility
as the receipt item (DOC_ITEM field) during line pairing. For paired
invoice lines, it is exported as the GRDocItem tag.
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Field Index Type Description

6 String Delivery document number.

7 Double Quantity.

8 Double Unit price.

9 Double Total amount.

10 Double Quantity invoiced.

11 Double Total invoiced.

12 String Receipt year.

Employee format

Table name: BRWEmployeeMaster

File name (for Agnostic ERP): employee.csv

Field Index Type Description

1 String Index ID of the employee record. This value is required.

2 Integer ID of the partition for the employee. This value is required.

3 String ID of the employee. This field is required.

4 String Employee name.

5 String First line of the employee's address.

6 String Second line of the employee's address.

7 String Employee's city.

8 String Employee's ZIP code.

9 String Employee's state.

10 String Employee's country code.

11 String Employee's telephone number.

12 String Employee's tax ID 1.

13 String Employee's tax ID 2.

Miscellaneous Charge format

Table name: MiscChargesAccount

File name (for Agnostic ERP): misc_charge.csv

Field Index Type Description

1 Integer PO partition. This field is required.

2 String Company code. This field is required.

3 String Category of the charge. This field is required.

4 String Plant.
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Field Index Type Description

5 String Line type.

6 String GL account number.

7 String Cost center.

8 String Profit center.

9 String Tax code.

Tax code format

Table name: TaxCode

File name (for Agnostic ERP): taxcode.csv

Field Index Type Description

1 Integer Partition ID.

2 String Vendor ID.

3 String Two-character country code. This value is required.

4 String Two-character code of the country where the item was shipped to.
This value is required.

5 String Two-character code of the country where the item was shipped from.
This value is required.

6 String If this is a service. Enter either Y or N.

7 String Material number.

8 String Material group.

9 Number Tax percentage. This value is required.

10 String Tax code.

Unit of Measure Conversion format

Table name: BRWUOMConversions

File name (for Agnostic ERP): uom_conversion.csv

Field Index Type Description

1 Integer PO partition. This field is required.

2 String Material number. This field is required.

3 String Base unit of measure. This field is required.

4 String Numerator for the unit of measure. This field is required.

5 String Denominator for the unit of measure. This field is required.

6 String External unit of measure. This field is required.
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Configure ERP import job schedule

To configure the optimal schedule, consider the amount of ERP master data. If you have a large amount
of ERP master data and you set the import job schedule to run too often, performance issues may occur.

You can set up a job schedule to import the ERP master data to the Kofax AP Agility database by
following these steps.

1. Log on to the TotalAgility Designer as an Administrator.
The Home page is displayed.

2. Select System Settings and then Job Schedules.
3. Click Add ( ) next to Job Schedules to create a new schedule.
4. Fill in the Job Schedule form as follows.

a. Enter a name for the Schedule Job.

b. Filter Process Explorer by the AP Agility category and then drag-and-drop the AP Data
Import job to the Process field.

c. Specify the Frequency.
It is recommended that you set up the import job schedule to run once per day. In case of
performance issues, ensure that the import occurs when the system if not heavily used. For
example, at night.

5. Click OK to save the import job schedule.

ERP import job status history

Kofax AP Agility keeps the following information about the executed import jobs in the
ERP_IMPORT_JOB_STATUS table in the Kofax AP Agility database.
• Job status ID
• Kofax AP Agility job ID
• Import datetime
• Import status
• Error messages
• Number of ERP invoices imported to the Kofax AP Agility database
• Number of payment terms imported
• Number of payment term details imported
• Number of PO headers imported
• Number of PO lines imported
• Number of receipt lines imported
• Number of vendors imported
• Number of GL segments imported
• Number of plants imported
• Number of employees imported
• Number of UOM conversions imported
• Number of tax codes imported
• Number of miscellaneous charges imported
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Localization
Kofax AP Agility supports localized end-user activities in English, French, German, Spanish, and Brazilian
Portuguese.

However, the translations for the Kofax TotalAgility Global Variables are not installed automatically when
Kofax AP Agility is installed. Instead, it is necessary to manually install the translations for these variables.

Install translations for global variables
Because translations for the Kofax TotalAgility Global Variables are not installed automatically when Kofax
AP Agility installed, it is necessary to do this manually.

You can manually install the translations for the Kofax TotalAgility Global Variables needed by Kofax AP
Agility by following these steps.

1. Launch the TotalAgility Designer.
2. On the Home page, click Form Designer.

The Form Designer page is displayed.
3. From the Import/Export group, click Import Languages.

The Import Languages page is displayed.
4. Click Browse, navigate to your extracted files, and then select /Languages/

KofaxAPAgility-2.2.0_Lang.zip.
The zip file is loaded automatically.

5. Click OK to start the import.
When the languages are imported successfully, a message appears. Click OK to close the window.
You are returned to the Form Designer page.

6. In the Manage group, click Translation.
7. In the left Explorer page, select Global Variables.

A list of variables is displayed.
8. Click Save.

This applies the imported translations to any forms that use one or more of the global variables.
9. Optionally, close the TotalAgility Designer.

Configure invoice processing
In order to use the invoice processing functionality of Kofax AP Agility, the following additional
configuration steps are required. Each step contains its own set of instructions and the order is important.
Skipping steps that are not optional, or performing steps out sequence can result in a failed installation.

1. Configure the invoice processing Administrator resource access.
To add additional resources, refer to the Help for Kofax AP Agility Settings.

2. Optionally, if you are using Windows authentication, configure the authentication type and timeout
session behavior.
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3. Create CSV files for database lookups.

4. Optionally, modify the recognition engines in Transformation Designer.
This step is necessary only if you are processing documents in languages other than English.

5. Prepare ingestion configuration.
• Configure filesystem ingestion.
• Configure scan ingestion.
• Configure email ingestion.

6. Configure page Image rendition.

7. Optionally, install PIX.

8. Restart the services.

Configure Invoice processing Administrator access
Before you can start configuring the Invoice processing functionality for Kofax AP Agility, it is necessary to
configure the Invoice processing Administrator access in the TotalAgility Designer.

You can configure the Invoice processing Administrator resource access by following these steps.
1. Launch the TotalAgility Designer.
2. On the Home page, click Resources.

The Resources page is displayed.
3. Under Explorer on the left pane, click Resources.
4. Select the InvoiceProcessingAgility category from the menu.

A list of groups related to invoice processing is displayed.
5. Click on the Group button to the left of the Administrators group and then click Open.

The properties for that group are displayed.
6. In the main panel, click on the Resource icon to the top-right of the Members box in the Groups

section.
The left panel is populated the available resources that you can include in the selected group.

7. Drag the Administrator resource into the Members group.
8. Click Save.

Your changes are saved and you are returned to the Resources page.
9. Optionally, if you are also using the AP Agility Workflow functionality, configure the AP Agility

Workflow Administrator resource.

CSV files for database lookups during invoice processing
Before you can use the invoice processing functionality of Kofax AP Agility it is necessary to create the
CSV files that are used by the database lookups that appear in the invoice processing Validation activity.
This is because the Associative Search Engine used by these database lookups requires a CSV file.

To aid in this, there is an automatic process to convert the BRWVendorMaster, BRWEmployeeMaster,
and the BRWCompanyAddressMaster database tables from the Kofax AP Agility database into CSV
format. These CSV files are then stored in Kofax TotalAgility and used by the database lookups.
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By default, the following three databases exist in Transformation Designer and they directly correlate to
the Kofax AP Agility database tables.
• VendorASE
• EmployeeASE
• CompanyCodeASE

However, there is no information available for these databases until you crease CSV files based on your
Vendor, Employee, and Company Code data.

If you are not using the Employee field, the BRWEmployeeMaster table is not needed. Similarly, if you
are getting the Company Code from the PO or from the file name, the BRWCompanyAddressMaster
table is not needed. You can leave one or both of these tables blank.

The BRWVendorMaster table is always used and needs populated with your own data.

If you do not have any vendor, employee, or company code data, you can still create the CSV files. This is
possible because mock data is provided for empty tables to ensure that the CSV creation succeeds. You
can add your own data to one or more of the master tables at a later time.

In order to ensure that the database lookups behave as intended, do the following.

1. Optionally, add your own data to the master tables that you are using.

2. Populate the CSV files.

3. Configure your CSV files to regularly update.

4. If you did not add data to the master tables earlier, add your data now.
The CSV files are update automatically the next time that your scheduled job is executed.
Alternatively, you can force the CSV file to update by running the same job that you used to create
the CSV files in the first place.

For more information on the Transformation Designer and how to use this tool, please refer to the Help for
Transformation Designer.

Vendor master data
Use the following table to prepare your Vendor Master data for export into the BRWVendorMaster
database table.

Note This table is mandatory. Populate it with your own data to ensure that the database locator is able
to reconcile your vendors during the invoice processing Validation activity.

70



Kofax AP Agility Installation Guide

Column Type Description Example

IndexID varchar A unique key for vendor addresses across all
partitions. This IndexID is a compound string
that is made up from the PartitionID, the ID
(Vendor), and if available, the SiteID.
The PartitionID and the ID are separated by
a hyphen (-). By default, the ID and SiteID are
separated by a tilde (~).
This separator between the ID and the SiteID is
configurable using the Alpha Num Site Separator
option in the Settings > IP Configuration >
Capture Profiles > Vendor Settings.

0-12345~5

In the above example,
the PartitionID is
0, the ID (Vendor) is
12345, and the SiteID
is 5.

PartitionID int The Vendor partition. This is used to distinguish
Vendors from different sources.

0

ID varchar The Vendor ID that is used in the ERP. 12345

SiteID varchar The SiteID for the associated Vendor. This may
not be used for some Vendors.
If this is used, it is part of the IndexID.

Note The SiteID is commonly used by
Oracle or PeopleSoft.

5

Name varchar Vendor name. Thumps Up

Address1 varchar First line of Vendor address. Drummers Lane

Address2 varchar Second line of Vendor address, if applicable.

City varchar City of the Vendor address. Houston

Zip varchar Post code or Zip code of the Vendor address. 77032

State varchar State or region of the Vendor address. TX

Country varchar Country of the Vendor address.
This must be given as an ISO 3166 Alpha-2
character code.

US

POBox varchar PO Box of the Vendor Address, if applicable. 12345678

POBoxZip varchar PO Box Zip code of the Vendor Address, if
applicable.

77032

EUMember varchar Indicates whether or not the Vendor is from a
country that is a member of the European Union.
Use an "X" to indicate that a Vendor is from an EU
country.
When a Vendor is from an EU country, this column
indicates when it is necessary to resolve tax codes
and provide VAT compliancy checks.

X

Currency varchar Currency of the Vendor Country.
The currency code must comply with the ISO 4437
code standard.

GBP
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Column Type Description Example

TAXID1 varchar The Primary Tax ID for a Vendor.
Kofax AP Agility does not require this for any
business logic. However, you can populate and
use this as a searchable field if needed.

TAXID2 varchar The Secondary Tax ID for a Vendor.
Kofax AP Agility does not require this for any
business logic. However, you can populate and
use this as a searchable field if needed.

VATRegNo varchar The Vendor VAT registration number(s).
Multiple VAT registration numbers must be
presented as a comma-separated list, if the
Vendor is VAT registered in more than one
country.
VAT registration numbers should contain the two-
character country prefix, but this is not mandatory.
This is used to populate the VendorVATRegNo
field if a VAT compliancy check is required.

DE118827839

TaxJurCode varchar The tax jurisdiction code.
Kofax AP Agility does not require this for any
business logic. However, you can populate this
field and access it in custom user exits.

TelNo varchar The Vendor telephone number.
Kofax AP Agility does not require this for any
business logic. However, you can populate and
use this as a searchable field if needed.

InvoiceType varchar The Vendor invoice type.
This must correspond to the configured PO
or NPO value specified in the Settings > IP
Configuration > Capture Profiles > Invoice
Type Settings.
This is relevant if the Set By Vendor value is set
only.

PO

PaymentMethods varchar A comma-separated list of Bank methods for the
Vendor.
This must match one of the methods configured
in the Settings > IP Configuration > Capture
Profiles > Payment Method Settings in order to
enable bank account extraction.

B,T
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Column Type Description Example

BankDetails varchar The bank account details for the Vendor.
This is a colon-separated list that uses the
following format.
BankAccount,SortCode,
ERPBankAccountCode:

Note A sort code is the US equivalent of a
routing number.

357357,,CAD1:
789789,,EUR1

In the above example,
the Vendor has two
different sets of
bank details. One for
Canadian dollars, and
another for Euros. In
both cases, the Vendor
does not have a sort
code.

WithholdingTax
Details

varchar A colon-separated list in the following format.
CompanyCode,WithholdingTaxType,
WithholdingTaxCode:

If there is withholding tax on the invoice at the time
of posting, the system posts the full withholding
tax amount to the entry with the relevant company
code.

Important This column is relevant for SAP
only.

CompanyCodes varchar A comma-separated list of company codes that
are valid for the Vendor.
Kofax AP Agility does not require this for any
business logic. However, you can populate this
field and access it in custom user exits.

UtilityFlag varchar Indicates if a Vendor is a utility vendor.
If used, this value for this must correspond to one
of the utility aliases configured in the Settings >
IP Configuration > Capture Profiles > Invoice
Number Settings.

PORSubscruberNo varchar The Swiss purchase order subscriber number for
the Vendor.
If this value is populated, it overrides the extracted
value during export.

ExternalVendorID varchar The external VendorID.
If a Vendor has a value for this field, it is used as
the ID (Vendor).
This is used by some ERP systems like Oracle
EBS.

ExternalSiteID varchar The external SiteID.
Kofax AP Agility does not require this for any
business logic. However, you can populate this
field and access it in custom user exits.

VendorAccountGroup varchar The Vendor account group. This is available for
export.
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Column Type Description Example

AlternatePayee varchar The Vendor alternate payee.
This is used for the ALTERNATIVEPAYYEE
export key if the AlternativePayee field is not
populated.

PermittedPayee varchar A comma-separated list of permitted alternative
payees for this Vendor. This list contains the
ID (Vendor) (without the PartitionID and
SiteID).

Important This is supported by SAP only.

12345

SiretID varchar The French SiretID for this Vendor, if applicable. RC NANTES 234 987
456

VendorIdentifier varchar A unique Vendor identifier, such as a Chinese tax
registration number.
This is used for vendor scoring if found on the
document.

InterCompany bit Indicates if a Vendor is an intercompany vendor.
Intercompany vendors are used only for vendor
extraction if the invoice is classified into the
Intercompany class.

Employee master data
Use the following table to prepare your Employee Master data for export into the BRWEmployeeMaster
database table.

Note If you are using the Employee field, populate this table with your own data

Column Type Description Example

IndexID varchar A unique key for employee addresses
across all partitions. This IndexID is a
compound string that is made up from the
PartitionID and the ID (Employee).
The PartitionID and the ID are
separated by a hyphen (-).

0-12345

PartitionID int The Employee partition. This is used
to distinguish Employees from different
sources.

0

ID varchar The Employee ID that is used in the ERP. 12345

Name varchar The Employee name. Michael Miller

Address1 varchar The first line of the Employee address. Drummers Lane

Address2 varchar The second line of the Employee address.

City varchar The Employee city. Houston
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Column Type Description Example

Zip varchar The Employee post code or zip code. 77032

State varchar The Employee state or region. TX

Country varchar The Employee country.
This must be given as an ISO 3166
Alpha-2 character code.

US

TelNo varchar The Employee telephone number.

TaxID1 varchar The Employee primary tax code.

TaxID2 varchar The Employee secondary tax code.

Company Code data
Use the following table tp prepare your Company Code data for export into the
BRWCompanyAddressMaster database table.

Note If you are getting the company code from this database table, populate it with your own data to
ensure that the database locator is able to reconcile company codes during the invoice processing
Validation activity.

Column Type Description

CompanyCode varchar A unique identifier for a company.

CompanyName varchar The name of a company.

CompanyAddress varchar The Company address. This address
should be similar to what is printed
on the invoice.

Dump address data to CSV databases
There is a process in Kofax TotalAgility that enables you to automatically create CSV files from the
BRWVendorMaster, BRWEmployeeMaster, and the BRWCompanyAddressMaster tables in the AP
Agility database. These files are then stored in Kofax TotalAgility.

You can create the CSV database needed for the database lookups in Transformation Designer by
following these steps.

1. Ensure that data is available in the AP Agility database for the BRWVendorMaster,
BRWEmployeeMaster, and the BRWCompanyAddressMaster tables.
If you have no data for these tables at this time, or you do not plan to use all three database lookups,
you can leave those tables blank. The CSV tables are created using mod data that you can update at
a later time when it is available.

2. Open the AP Agility Workspace.
3. From the Jobs menu, select Create.

The Create Jobs page is displayed.
4. From the Category list, select InvoiceProcessingAgility.

The Process list is populated with processes.
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5. From the Process list, select DumpAddressFiles
6. Click Create.

A message is displayed when the job is created successfully and the Vendor.csv, Employee.csv, and
CompanyCode.csv files are created automatically. These files are stored in Kofax TotalAgility and
picked up automatically by the corresponding database locators in the Transformation Designer.
However, it is still necessary to Release your project in Transformation Designer after you create the
CSV databases.

Release project with new database references
When Kofax AP Agility is first installed, three database lookups are created in Transformation Designer
automatically. Now that you have dumped your address data to CSV files that are stored in Kofax
TotalAgility, it is necessary to open and then release your project in Transformation Designer so that the
newly created databases are use.

You can update the project and its databases by following these steps.
1. If not already done, dump your address data.
2. Open the Transformation Designer.
3. From the Project tab, click Open Project.

The Open Project window is displayed.
4. From the Select category group, select the InoviceProcessingAgility category.

The Select project area is updated.
5. In the Select project area, expand Shared, and then double-click on the InvoiceProcessingAgility

project.
The project opens.

6. On the Project tab, click Project Settings.
The Project Settings window is displayed.

7. In the Project Settings window, click on the Databases tab.
The Databases tab is displayed.

8. Select the VendorASE database and click Import.
When prompted to import the database click Yes.
The corresponding CSV file is imported.

9. If you are using the Employee field, select the EmployeeASE database and click Import.
When prompted to import the database click Yes.
The corresponding CSV file is imported.

10. If you are using the Company Code field, select the CompanyCodeASE database and click Import.
When prompted to import the database click Yes.
The corresponding CSV file is imported.

11. On the Project Settings window, click OK.
Your changes are saved and the window closes.

12. On the Project tab, click Release.
The project is released with the updated databases.

13. Close the Transformation Designer.
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Configure CSV databases to update automatically
When you converted the BRWVendorMaster, BRWEmployeeMaster, and the
BRWCompanyAddressMaster database tables into CSV databases, that was a single point-in-time
representation of that data. Since it is likely that some of those tables are modified regularly with additional
data over the lifetime of your project, it is necessary to update the CSV files at regular intervals.

You can update the CSV databases at regular intervals by following these steps.
1. Launce the TotalAgility Designer.
2. Optionally, log on with your Kofax TotalAgility Administrator user credentials if prompted.
3. On the Home page, click System Settings.

The System Settings page is displayed.
4. On the System Settings page, click Job Schedules.

A list of scheduled jobs is displayed for the default category.
5. From the Categories list, select InvoiceProcessingAgilty.

A filtered list of scheduled jobs is displayed.
6. Double-click on the AddressData2CSV scheduled job.
7. When prompted, click Yes to lock the scheduled job for modification.

The properties for the job are displayed.
8. For the Active option, set it to Yes.
9. Edit the Frequency and Range of Recurrence settings as necessary.

For more information on these settings, see the Help for Kofax TotalAgility.
10. In the upper-right corner, click OK to save your settings.

You are returned to the list of scheduled jobs and your CSV files are now configured to update at
regular intervals.

11. Optionally, Close the TotalAgility Designer.

Modify the Transformation Designer recognition engines
If you are processing documents in languages other than English, it is recommended that you update the
recognition engines in the Transformation Designer. This ensures that the recognition engines are more
efficient for your needs than they are by default.

You can modify the recognition engines by following these steps.
1. Open the Transformation Designer.
2. From the Project tab, click Open Project.

The Open Project window is displayed.
3. From the Select category group, select the InoviceProcessingAgility category.

The Select project area is updated.
4. In the Select project area, expand Shared, and then double-click on the InvoiceProcessingAgility

project.
The project opens.

5. On the Project tab, click Project Settings.
The Project Settings window is displayed.
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6. On the Project Settings window, click the Recognition tab.
A list or recognition engines is displayed.

7. Double-click on the default FineReader recognition engine.
This is the third entry in the list.
The FineReader Profile Settings window is displayed.

8. In the Languages list, select each language that your process.

Tip For the best results, ensure that Digits and English are selected in addition to any other
languages selected.

9. Click OK to save your changes.
The FineReader Profile Settings window closes.

10. Click OK to save changes to the project settings.
The Project Settings window closes.

11. On the Project tab, click Release.
The project is released with the updated databases.

12. Close the Transformation Designer.

Prepare ingestion configuration
Before you can configure individual types of ingestion, you first need to create a general import connection
for Kofax AP Agility invoice processing. Once the import connection is available, you can add filesystem
and email ingestion.

Note If you are using Kofax AP Agility in an Azure environment, use the Kofax TotalAgility Integration
Server to configure ingestion.

You can add an import connection by following these steps.
1. Launch the TotalAgility Designer.
2. Optionally, log on with your Kofax TotalAgility Administrator user credentials if prompted.
3. On the Home page, click Integration.

The Integration page is displayed with several options under the Manage category.
4. Click Import Settings.

The Import Settings page is displayed, but there are no Import Connections configured.
5. Click  next to Import Connections.

The Import Connection page is displayed.
6. Enter a Name such as "InvoiceProcessing."
7. Enter a Description for your new connection.
8. Configure the Message Connector URL settings.

a. From the Windows Start menu, select Start > Kofax > Message Connector > Message
Connector Monitor.
The Message Connector Web Portal website is displayed.

b. Copy the hostname and port for the Message Connector Web Portal and then paste them into
the Message Connector URL field back on the Import Connection page.
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9. Edit the other settings based on your requirements.
For more information on these settings, see the Help for Kofax TotalAgility.

10. In the upper-right corner, click OK to save your settings.
Your changes are saved and you are prompted to restart the following services.
• Kofax TotalAgility Core Worker
• Kofax Transformation Server
• World Wide Web Publishing Service

Afterward, you are returned to the Import Connections page where your new import connector is
listed.

Configure filesystem ingestion
You can configure filesystem ingestion by following these steps.

1. Launch the TotalAgility Designer.
2. Optionally, log on with your Kofax TotalAgility Administrator user credentials if prompted.
3. On the Home page, click Integration.

The Integration page is displayed with several options under the Manage category.
4. Click Import Settings.

The Import Settings page is displayed.
5. Under Import Connections, click the name that you provided when you created the ingestion

connection.

The import connection you created earlier is visible but it has no Import Sources.
6. Click  next to Import Sources.

The Import Source page is displayed.
7. In the Type list, select the import source type as FILE.
8. Enter a Display Name, such as "IPFilesystemImport."
9. If you are using Kofax TotalAgility 7.6.0 or later, ensure that the Normalize images and create

pages option is selected.
10. Edit the other settings as needed.

For more information on these settings, see the Help for Kofax TotalAgility.
11. Optionally, click Test File Import.
12. Ensure that the Job Type is set to Create New Job.
13. Drag-and-drop the InvoiceProcessingAgility process called Capture Document into the Process

field on your Input Source.
The Map Variables section is populated with Metadata and Initialization Variables.

14. From the Metadata column, drag-and-drop the Import Source Type metadata so that it maps to the
Input Source.

15. Drag-and-drop the File Name metadata so that it maps to the Filename.
You can map additional fields, but if you do, this mapping overrides the mapping configured in the
Settings > IP Configuration > Global settings > Import Settings.

16. In the upper-right corner, click OK.
Your changes are saved and the Import Connection page is updated with your newly created
Import Source.
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17. Click Close to exit the Import Connection page.
18. Optionally, close the TotalAgility Designer.

Configure scan ingestion
You can configure scan ingestion by following these steps.

1. Open the AP Agility Workspace.
2. From the AP Agility Workspace menu, select Scan

The Kofax Web Capture Service Required window is displayed.
3. Install the Kofax Web Capture Service by clicking the click here link in the window.

A progress bar is displayed while the installation occurs.
4. Click OK to close the Kofax Web Capture Service Required window after the installation is

complete.
5. Optionally, configure the settings to scan documents in languages other than English.
6. Refresh the Scan page.

This ensures that the newly installed Web Capture Service is accessible to Scan.

Configure language settings

If your invoices are in a language other than English, you can improve the extraction results by selecting
the relevant language before scanning your documents. To aid in document recognition, these languages
are available for selection at the point of scan.

1. Chinese

2. Japanese

3. Korean

4. Thai

5. Greek

6. Russian

Depending on which of the above language is selected, a dedicated recognition profile is available
in Transformation Designer. Each of these languages has its own profile that is configured to extract
documents in the relevant language. Using one of these dedicated recognition profiles ensures better
extraction results than the default recognition profile. For more information on recognition profiles, refer to
the Help for Transformation Designer.

You can configure scan language settings by following these steps.
1. Open the AP Agility Workspace.
2. From the AP Agility Workspace menu, select Scan
3. On the Scan form, select the language from the Language ID list.
4. Refer to the Configure scan ingestion to complete the remaining steps of the ingestion process.

Configure email ingestion
If you plan to process invoices received by one or more email addresses, email ingestion is necessary. An
email import process is required for each email address that you process. This is configured in the same
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location as filesystem ingestion. For more information on ingestion and its various settings, refer to the
Help for Kofax TotalAgility.

You can configure email ingestion by following these steps.
1. Launch the TotalAgility Designer.
2. Optionally, log on with your Kofax TotalAgility Administrator user credentials if prompted.
3. On the Home page, click Integration.

The Integration page is displayed with several options under the Manage category.
4. Click Import Settings.

The Import Settings page is displayed.
5. Under Import Connections, click the name that you provided when you created the ingestion

connection.

The import connection you created earlier is visible but it has no Import Sources.
6. Click  next to Import Sources.

The Import Source page is displayed.
7. In the Type list, select the import source type as POP3.
8. Enter a Display Name such as "IPEmailImport."
9. Enter your email service provider into the Host field.

10. Enter a Username and Password.
11. Test your settings by clicking Test Mailbox.
12. Ensure that the Job Type is set to Create New Job.
13. Drag-and-drop the InvoiceProcessingAgility process called Capture Document into the Process

field on your Input Source.
The Map Variables section is populated with Metadata and Initialization Variables.

14. Drag the Import Source Type into the Input Source mapping field.
15. Enter a Client ID.

You can either hard code a Client ID or you can select one of the metadata variables. If you do map
a variable, you need to modify the CaptureDocument profess so that it can use the Metadata value
and process it accordingly.

16. In the upper-right corner, click OK.
Your changes are saved and the Import Connection page is updated with your newly created Input
Source.

17. Click Close to exit the Import Connection page.
18. Optionally, close the TotalAgility Designer.
19. On your mail server, do the following.

a. In the email account specified above, enable POP download in the account settings.

b. Configure the settings to allow Kofax AP Agility to access your email account.
Your settings are now configured to use email ingestion.
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Image rendition
Rendition is used in invoice processing stage of Kofax AP Agility to keep a copy of the originally ingested
document when ImageProcessing activities are performed. For example, copies are kept for a PDF, a
200 DPI image, or a color TIFF image.

The ImageProcessing activities in the main process convert all documents to 300 DPI black and white
TIFF images.

The original document is stored in rendition.

Add image rendition
You need to add image rendition to the system and provide "Original" as its name.

You can add image rendition by following these steps.
1. Launch the TotalAgility Designer.
2. Optionally, log on with your Kofax TotalAgility Administrator user credentials if prompted.
3. On the Home page, click System Settings.
4. In the Manage group, select Page Renditions.
5. If no rendition is available, define one and name it Original.

User Exit assemblies
Before you can use the various User Exits available for invoice processing in Kofax AP Agility, you must
first implement their assemblies and then install them.

For more information on the User Exits and how to use them for invoice processing, see the Help for
Kofax AP Agility Settings

Implement User Exit assemblies
In order to make use of the available user exits, you must first implement the user exit assemblies by
following these steps.

1. Create a new project for a .NET class library.
2. Include references to the following assemblies.

• ICAL.ComponentAccess

• ICAL.Framework

• ICAL.Invoices

Note These assemblies are located in the Assemblies directory of your Kofax AP Agility installation
files.

3. If you are using SAP, add references to the following assemblies.
• ICAL.Framework.SAP

• ICAL.Invoices.SAP
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4. If you are using an Oracle database, add references to the following assemblies.
• ICAL.Framework.Oracle

5. Sign your new assembly.
This is necessary for installation to the global assembly cache.

6. Create a class that implements ICAL.Invoices.Custom.ICustomInitializer.
7. Implement the Initialize(ProjectContext) method.
8. Within the Initialize(ProjectContext) method, register your user exits in the

UserExitsRegistry that is available as the ProjectContext property.
You can implement and register as many user exits as are required.

9. Compile your assembly and give it a meaningful name such as UserExitAssembly.dll.
A DLL file is generated with the provided name.

10. Install it to the global assembly cache.

Example: Modify Vendor Addresses

You want to modify vendor addresses after that are loaded from the vendor pool or database. To do this,
implement and register the ReadVendorAddress delegate and then:
using ICAL.ComponentAccess;
using ICAL.Invoices;
using ICAL.Invoices.Data;
using ICAL.Invoices.Custom;

namespace UserExits
{
    public class MyUserExits : ICustomInitializer
    {
        public void ReadVendorAddress(IField field, 
          string vendorId, IVendorAddress vendorAddress)
        {
            // your code here
        }

        public void Initialize(ProjectContext ctx)
        {
            ctx.UserExits.ReadVendorAddress = ReadVendorAddress;
        }
    }
}

Install the User Exit assembly to GAC
After compiling your assembly, it needs installed to the global assembly cache (GAC) before it is usable.
Even though you can use a tool like gacutil to install the DLL file, it is recommended that you use the
provided Install2GAC.exe tool to install your assembly to the GAC.

You can install your assembly DLL to the GAC by following these steps.
1. Copy the UserExit folder that is included with your installation files to the machine where you are

installing the assemblies.
This folder contains the Install2GAC.exe tool.

2. Copy your recently implemented User Exit Assembly dll file to the UserExit folder that you copied in
the previous step.
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3. Open a command line with administrative privileges and enter the following.
Install2GAC.exe <YourUserExitAssembly>.dll
Press Enter.
Your user exit assembly is installed to the GAC.

4. Optionally, if your assembly has any dependencies to additional third-party assemblies, install those
assemblies to the GAC as well.

5. Edit the server variables in TotalAgility Designer
Depending on whether you register an assembly for the 32-bit extraction phase, or the 64-bit
validation, line pairing, and export phase, you need to set one of the following combinations in the
InvoiceProcessingAgility category.
• IPAUserExitExtractionAssembly and IPAUserExitExtractionClass
• IPAUserExitValidationAssembly and IPAUserExitValidationClass

The IPAUserExitExtractionAssembly and IPAUserExitValidationAssembly
must contain the strong name of your assembly. For example,  IPAUserExitDemo,
Version=1.0.0.0, Culture=neutral, PublicKeyToken=6a3a0087b9ef9c25,
processorArchitecture=MSIL.
The IPAUserExitExtractionClass and IPAUserExitValidationClass must contain the
name of the class that implements the ICustomeInitializer interface.

PIX installation
PIX is a Windows application that processes structured XML invoice formats and then converts them to
PDF format. This generated PDF is a rendition of the electronic content for visualization purposes. This
electronic data is automatically copied to the respective invoice fields for invoice processing.

PIX generates the field content and a PDF based on out-of-the-box mappings for the following electronic
standards.
• OIOUBL Invoice
• OIOUBL Credit Note
• OIOXML
• General XML
• E2B
• ZUGFeRD
• ebInterface
• Facturae
• ESXML
• Finvoice
• Svefaktura

Important You should install and configure PIX if you need to process the above types of XML
documents only.

PIX also comes with a thin-client mapping correction utility that allows users to improve and advance the
default XML-to-Field mappings. For more information, see the PIX Correction Help.
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PIX is comprised of two components, a server and a client. It is common for the PIX server and the PIX
client to be installed together on the same server. For the best results, install these together, but on a
separate machine from Kofax AP Agility and Kofax TotalAgility.

If necessary, the PIX server and the PIX client can be installed on separate servers.

Note PIX supports Western character sets only. This means that it does not support CJKT characters or
extended characters required for languages such as Russian or Greek.

PIX prerequisites
Before you can install PIX, the following prerequisites are required.
• Microsoft SQL Server
• Internet Information Service (IIS) with ASP.NET 3.5, ASP.NET 4.5, and WebSockets

Install PIX client and server on the same server
In most situations, it is recommended that you install the PIX server and the PIX client on the same server,
but a different server to Kofax TotalAgility. If you anticipate processing documents through PIX on a
regular basis, consider installing PIX on a separate server. This ensures that PIX does not compete with
Kofax TotalAgility or Kofax AP Agility for resources. Also, Kofax TotalAgility and Kofax AP Agility both must
be installed before you can install PIX.

You can install the PIX client and server on the same server by following these steps.
1. Navigate to your extracted files and open the PIX_Installer folder.

The contents of the PIX_Installer folder are displayed.
2. Double-click on the PixSetup.exe file.

The Kofax PIX installation window is displayed.
3. On the Kofax PIX Installer, select I agree to the license terms and conditions.

Leave both Install PIX Server and Install PIX Client selected.
4. Click Install.

The PIX installation starts and the PIX Server Setup Wizard is displayed.
5. Click Next twice, and stop when you get to the Database settings step.
6. If your user account does not have the necessary permission to create a database, clear the Create

database option.
A database administrator can create the PIX server database manually after the PIX server
installation finishes.
If you do have permission to create a database, select Create database and then provide the
Database server name and the Instance name if needed.

7. Click Next.
The Web site step is displayed.

8. For the best results, modify only the Log Folder, if necessary. Leave the other settings as default.
Make a note of the Port number. This is needed when configuring Kofax AP Agility later.
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9. If you do not have access to a user account that has permission to create a website, clear the Create
website option.
An administrator can manually create the PIX server website manually after the PIX server
installation finishes.
If you do have access to a user account that has permission to create a website, select Create
website.

10. Click Next.
The Kofax TotalAgility Connection screen is displayed.

11. On the Kofax TotalAgility Connection screen, enter the TotalAgility URI.
For example, http://<servername>/TotalAgility/

12. Click Next.
If you are creating a website, the User credentials screen is displayed. If you chose not to create a
website, click Next and then skip to step 15.

13. If you are creating a website, modify the Domain name, User name, and associated Password.
14. Click Next.

This user must have permissions to create a database and a web site in IIS.
The Install screen is displayed.

15. Click Install.
PIX server is installed.

16. Click Finish.
The PIX Client Setup Wizard is displayed.

17. Click Next.
The Destination Folder page is displayed.

18. Optionally, click Change to modify where the PIX client is installed.
19. Click Next.

The PIX Client settings page is displayed.
20. Take note of the PIX server URI as this is needed later and ensure that the Create website option is

selected.
21. Click Next and then Install.

The PIX Client is installed.
22. When the installation completes, click Finish.

A message that confirms a successful installation is displayed.
23. Click Close.
24. Configure the PIX Web.config file.

Install PIX server only
It is common to install both the PIX server and the PIX client on the same server. However, in certain
situation, you may not want the PIX client and PIX server installed on the same server. Even though the
PIX server and the PIX client use the same installer, it is possible to install them on separate machines.
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You can install the PIX server only by following these steps.
1. Decide where to install PIX server.

Note If you are installing PIX on a separate server than Kofax AP Agility, copy over the
PIX_Install/PixSetup.exe file from your extracted files.

2. Double-click on the PixSetup.exe.
The Kofax PIX installation window opens.

3. On the Kofax PIX Installer, select I agree to the license terms and conditions.
4. Clear Install PIX Client.

This installs the PIX server only.
5. Click Install.

The PIX installation starts and the PIX Server Setup Wizard is displayed.
6. Click Next twice, and stop when you get to the Database settings step.
7. If your user account does not have the necessary permission to create a database, clear the Create

database option.
A database administrator can create the PIX server database manually after the PIX server
installation finishes.
If you do have permission to create a database, select Create database and then provide the
Database server name and the Instance name if needed.

8. Click Next.
The Web site step is displayed.

9. For the best results, modify only the Log Folder, if necessary. Leave the other settings as default.
Make a note of the Port number. This is needed when configuring Kofax AP Agility later.

10. If you do not have access to a user account that has permission to create a website, clear the Create
website option.
An administrator can manually create the PIX server website manually after the PIX server
installation finishes.
If you do have access to a user account that has permission to create a website, select Create
website.

11. Click Next.
The Kofax TotalAgility Connection screen is displayed.

12. On the Kofax TotalAgility Connection screen, enter the TotalAgility URI.
For example, http://<servername>/TotalAgility/

13. Click Next.
If you are creating a website, the User credentials screen is displayed. If you chose not to create a
website, click Next and then skip to step 16.

14. If you are creating a website, modify the Domain name, User name, and associated Password.
15. Click Next.

This user must have permissions to create a database and a web site in IIS.
The Install screen is displayed.

16. Click Install.
PIX server is installed.

17. When the installation completes, click Finish.
A message that confirms a successful installation is displayed.
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18. Click Close.

Install PIX client only
Although it is not common, it is possible to install the PIX client on a different server than the PIX server.

You can install the PIX client on a separate server by following these steps.
1. Decide where to install the PIX client.

Note If you are installing PIX on a separate server than Kofax AP Agility, copy over the
PIX_Install/PixSetup.exe file from your extracted files.

2. Double-click on the PixSetup.exe.
The Kofax PIX installation window opens.

3. On the Kofax PIX Installer, select I agree to the license terms and conditions.
4. Clear Install PIX Server.

This installs the PIX client only.
5. Click Next.

The Destination Folder step is displayed.
6. Optionally, click Change to modify the installation path
7. Click Next.
8. Enter a value in the PIX server URI field.

This refers to the server name and port number recorded during the PIX server installation.
For example, http://<servername>:<port>.

9. If you do not have access to a user account that has permission to create a website, clear the Create
website option.
An Administrator can manually create the PIX Client website manually after the PIX Client installation
finishes.
If you do have access to a user account that has permission to create a website, select Create
website.

10. Click Next.
11. Click Install.

The PIX client is installed.
12. When the installation completes, click Finish.

A message that confirms a successful installation is displayed.
13. Click Close.

Configure PIX web.config
Regardless of where the PIX server is installed, it is necessary to configure the PIX server web.config file
after installation. This is true if you installed both PIX server and PIX client on the same server, of if you
installed PIX server on a different server to the PIX client.

If you do not update the configuration file, it is likely that documents will fail PIX processing and that users
cannot access PIX Correction.
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You can update the PIX Web.config file by following these steps.
1. Navigate to <Program Files>\Kofax\PIX\PIXServer or wherever you installed PIX.
2. Edit the Web.config file.
3. Search for the <add key "hostname" value and edit it so that the hostname uses the fully-

qualified domain server name of where PIX is installed.
4. Save the Web.config file.
5. Restart the World Wide Web Publishing Service for your change to take effect.

Create PIX server database manually
When PIX server is installed, that user may not have the necessary permissions to create the PIX server
database. It is common for a company to restrict database creation to dedicated database administrators,
so they must create the database by following these steps.

1. Open Microsoft SQL Server Management Studio.
2. Create a new database.

Name the database "SmartXML."
It is recommended that you use this name, but if you want to use another, the connection string in the
Web.config file needs updated to use this new name.

3. In Windows Explorer, navigate to where you installed PIX server.
By default, this path is <Program Files>\Kofax\PIX\PIXServer.

4. In Microsoft SQL Server Management Server, execute the CreateTables.sql script located in the
DbScripts folder.
The script is executed and the necessary database tables are created.

Create PIX server website manually
If the user that installed PIX server does not have the necessary permissions to install the PIX server
Website, an administrator can do so by following these steps.

1. Launch IIS.
2. In the Connections pane, expand http://localhost represented by your computer name.

A list of Application Pools and Sites is displayed.
3. Select and then right-click on Application Pools. Select Add Application Pool.

The Add Application Pool window is displayed.
4. In the Add Application Pool window, enter a name for your application pool such as "PIXAppPool."

a. From the .NET Framework version list, select .NET Framework v4.0.XXXXX.

b. From the Managed pipeline mode list, select Integrated.

c. Select the Start application pool immediately.

d. Click OK.
The new application pool is created is added to the list.

5. Right-click on Sites and select Add Web Site.
The Add Web Site window is displayed.

6. In the Site name field, enter "PixServer".
7. Select the newly added PIXAppPool from the Application Pool.
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8. Browse to find the physical path of the Physical path.
By default, this is <Program Files>\Kofax\Pix\PixServer.

9. In the Binding group, set the Port to "53060."
This is the port number specified during installation.

10. Configure all other settings as appropriate for your needs and then click OK.
The new site is added to the list of sites.

Create PIX client website manually
If the user that installed PIX Client does not have the necessary permissions to install the PIX Client
Website, an Administrator can do so by following these steps.

1. Launch IIS.
2. In the Connections pane, expand http://localhost represented by your computer name.

A list of Application Pools and Sites is displayed.
3. Expand Site.

A list of applications is displayed.
4. Right click on the Default Web Site and select Add Application.

The Add Application window is displayed.
5. In the Alias field, enter "Pix."
6. Select the "PixAppPool" from the Application Pool.
7. Browse and select <Program Files>\Kofax\Pix\PixClient\src for the Physical path.
8. Configure all other settings as appropriate for your needs and then click OK.

The new application is added to the Default Web Site list.

Configure Kofax AP Agility to use PIX
Now that you have installed PIX you need to tell Kofax AP Agility where it is installed and how to access it.

You can configure Kofax AP Agility to use PIX by following these steps.
1. Log on to the Kofax AP Agility Workspace.

The Kofax TotalAgility Workspace for Kofax AP Agility is loaded.
2. Click Settings > Administration.

The Administration page is loaded.
3. In the PIX section, enter the Web client URI.

For example, http://localhost/PIX.
4. Enter the Web server URI.

This is the path recorded when you installed the PIX Client.
For example, http://localhost:53060.

5. Click Save PIX Settings.
The PIX settings are saved and you can now use PIX during invoice processing.
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Configure XML handling to use PIX
When you first install Kofax AP Agility and then PIX, XML handling is done by Kofax TotalAgility. If you
want to use PIX to process and correct documents, a change to the existing configuration is necessary.
XML handling is configured in the Kofax Message Connector.

You can configure XML handling to use PIX by following these steps.
1. Click Start > Kofax > Message Connector > Message Connector Configuration.

The Message Connector Configuration window is displayed.
2. Expand the Structured (XML) Input Handling section.

A list of XML options is displayed.
3. In the Types field, replace the existing content with .none.
4. Scroll to the top and click Save.

A message confirming that your changes have saved is displayed.
5. Click Exit and restart service.

The service is restarted and the Message Connector window is closed.

Restart the services
You need to restart the following services to complete the Kofax AP Agility installation.
• Kofax TotalAgility Core Worker
• Kofax Transformation Server
• World Wide Web Publishing Service

Configure the AP Agility Workflow
After installing Kofax AP Agility, it is necessary to configure the AP Agility Workflow administrative
resource. Otherwise, it is not possible to administer the AP Agility Workflow aspects of Kofax AP Agility.

Configure AP Agility Workflow Administrator access
Before you can start configuring the AP Agility Workflow functionality for Kofax AP Agility it is necessary to
configure AP Agility Workflow Administrator access in the TotalAgility Designer.

You can configure the AP Agility Workflow Administrator resource access by following these steps.
1. Launch the TotalAgility Designer.
2. On the Home page, click Resources.

The Resources page is displayed.
3. Under Explorer on the left pane, click Resources.
4. Select the AP Agility category from the menu.

A list of groups related to AP Agility is displayed.
5. Click on the Group button to the left of the Administrators group and then click Open.

The properties for that group are displayed.
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6. In the main panel, click on the Resource icon to the top-right of the Members box in the Groups
section.
The left panel is populated the available resources that you can include in the selected group.

7. Drag the Administrator resource into the Members group.
8. Click Save.

Your changes are saved and you are returned to the Resources page.
9. Optionally, if you have not already done so, and are also using the Invoice processing functionality,

configure the Invoice processing Administrator access.

AP Agility workspace
After successfully installing Kofax AP Agility, the Kofax AP Agility workspace is available to the AP Agility
user. The Kofax AP Agility workspace includes the Kofax AP Agility site and workqueue.

Kofax AP Agility site
The SPA package creates the Kofax TotalAgility site called AP Agility with the following settings.

Site Parameter Parameter Value Comment

Category Kofax AP Agility Installed with the Kofax AP Agility
package

Name Kofax AP Agility The site name in Kofax AP Agility
URL

Header Form Workspace_Header_2 Installed with the Kofax AP Agility
package

Horizontal Navigation Kofax AP Agility Menu Installed with the Kofax AP Agility
package

Vertical Navigation N/A N/A

Default Form TotalAgility Work Queue Standard Kofax TotalAgility form

Theme TotalAgility Workspace Standard Kofax TotalAgility theme

For an on-premise installation, Kofax TotalAgility is set up to use Integrated Windows Authentication to
authenticate users. You can also configure Kofax AP Agility to use Windows Authentication.

The Kofax AP Agility site URL address must be in the following format, depending on the installation:
• On-premise: http(s)://<kta_server>/TotalAgility/forms/APAgility
• Azure: https://<kta_server>/forms/APAgility

In both cases, <kta_server> is the Kofax TotalAgility server host name.

Work Queue form
Kofax AP Agility uses the standard Work Queue form to access invoices.
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Change your Kofax AP Agility installation

It is possible to remove or change the features that are installed on your server. This is possible using the
same installer that you used to install Kofax AP Agility in the first place. In fact, if you run the installer on
a server where any component of Kofax AP Agility is installed already, the installer only lets you Change,
Repair, or Remove Kofax AP Agility.

You can also use the Change option to update any configuration settings as necessary. For example, the
Web Server where the ERP Connector Web Service is installed is replaced with a newer server. As a
result, it is necessary to install and configure the ERP Connector Web Service again.

You can change your Kofax AP Agility installation by following these steps.
1. Navigate to your extracted files and open the Installer folder.

The contents of the Installer folder are displayed.
2. Right-click on the Kofax AP Agility installer and select Run as Administrator to begin the Setup

Wizard.
The installer opens and calculates if there is enough space on disk for the installation.

3. Click Next.
The Change, Repair, or Remove Installation window is displayed.

4. Click Change.
The Prerequisites Setup Wizard step is displayed along with any information about missing
prerequisites.

5. The information displayed on the Prerequisites step is relevant if you are installing the listed
components only.
For example, if you receive a message that the SAP .NET connector is missing, but you are not
using SAP, ignore this message. However, if you are using one of the components listed, click
Cancel and then Finish to exit the Setup Wizard, install the required prerequisite, and then restart
the installer. Otherwise, click Next.
If you did not install the necessary prerequisites, the corresponding options are not available for
installation.
The Custom Setup step is displayed indicating the features that are already installed.
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6. To remove an already installed feature, chance it so that the Entire feature will be unavailable. To
install a feature that was previously not included, or to make changes to an already installed feature,
select Will be installed on local drive.
Once you select the necessary components, click Next.
Use the links below to change or install each of the following features as appropriate for your
installation.
• AP Agility assemblies
• AP Agility database connection
• Kofax TotalAgility Integration/package
• ERP Connector Web Service

Once you have made the necessary changes, click Change.
A progress indicator shows the progress of the Kofax AP Agility installation.

7. Click Finish.
Optionally, select the View Installation Log option. This opens the log file once the installer is
closed.
The installer closes and if selected, the log file opens.

Remove a feature
If you no longer need a Kofax AP Agility feature, you can remove that individual feature rather than the
entire product.

For example, you have the ERP Connector Web Service installed on your computer but you have a new
dedicated Web Server. You can use the installer to remove the ERP Connector Web Service so that you
do not have to do this manually. You can then run the installer another time, in custom mode to install the
ERP Connector Web Service on the new server.

You can remove a Kofax AP Agility feature by following these steps.
1. Navigate to your extracted files and open the Installer folder.

The contents of the Installer folder are displayed.
2. Right-click on the Kofax AP Agility installer and select Run as Administrator to begin the Setup

Wizard.
The installer opens and calculates if there is enough space on disk for the installation.

3. Click Next.
The Change, Repair, or Remove Installation window is displayed.

4. Click Change.
The Prerequisites Setup Wizard step is displayed along with any information about missing
prerequisites.

5. The information displayed on the Prerequisites step is relevant if you are installing the listed
components only.
For example, if you receive a message that the SAP .NET connector is missing, but you are not
using SAP, ignore this message. However, if you are using one of the components listed, click
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Cancel and then Finish to exit the Setup Wizard, install the required prerequisite, and then restart
the installer. Otherwise, click Next.
If you did not install the necessary prerequisites, the corresponding options are not available for
installation.
The Custom Setup step is displayed indicating the features that are already installed.

6. For the feature or features that you are removing, select Entire feature will be unavailable and then
click Next.
The Ready to Change Kofax AP Agility 2.2.0 Setup Wizard step is displayed.

7. Click Change.
A progress indicator shows the progress of the Kofax AP Agility installation.

8. Click Finish.
Optionally, select the View Installation Log option. This opens the log file once the installer is
closed.
The installer closes and if selected, the log file opens.

Add a feature
Because environments change regularly, it is possible to add a Kofax AP Agility feature at a later time, if
necessary.

For example, if you use SAP and the prerequisites were not installed when you first installed Kofax
AP Agility, you can go back at a later time and install this feature once the necessary prerequisites are
installed.

You can add a feature to Kofax AP Agility by following these steps.
1. Navigate to your extracted files and open the Installer folder.

The contents of the Installer folder are displayed.
2. Right-click on the Kofax AP Agility installer and select Run as Administrator to begin the Setup

Wizard.
The installer opens and calculates if there is enough space on disk for the installation.

3. Click Next.
The Change, Repair, or Remove Installation window is displayed.

4. Click Change.
The Prerequisites Setup Wizard step is displayed along with any information about missing
prerequisites.

5. The information displayed on the Prerequisites step is relevant if you are installing the listed
components only.
For example, if you receive a message that the SAP .NET connector is missing, but you are not
using SAP, ignore this message. However, if you are using one of the components listed, click
Cancel and then Finish to exit the Setup Wizard, install the required prerequisite, and then restart
the installer. Otherwise, click Next.
If you did not install the necessary prerequisites, the corresponding options are not available for
installation.
The Custom Setup step is displayed indicating the features that are already installed.
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6. For any feature that you want to install that is not already installed, select Will be installed on local
hard drive and then click Next.
The Ready to Change Kofax AP Agility 2.2.0 Setup Wizard step is displayed.

7. Click Change.
A progress indicator shows the progress of the Kofax AP Agility installation.

8. Click Finish.
Optionally, select the View Installation Log option. This opens the log file once the installer is
closed.
The installer closes and if selected, the log file opens.
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Repair Kofax AP Agility

If your Kofax AP Agility installation fails because some files are corrupted or missing, you can run the
repair option from the installer.

This repair option reinstalls some of the features that you originally installed, such as assembles and the
ERP Connector Web Service.

The repair however, does not recreate the Kofax AP Agility database or the Kofax TotalAgility package.
This ensures that you do not lose any of your configurations made up to this point.

In most cases the repair occurs automatically. All features are updated and repaired without user
interaction.

However, if you have the ERP Connector Web Service installed, and depending on how you installed
this in the first place, some manual user interaction may be required. If you selected Custom Account for
the Pool Identity when setting up the ERP Connector Web Service, you are asked to provide these user
credentials for the specified user account before you can repair your Kofax AP Agility installation.

You can repair your Kofax AP Agility installation by following these steps.
1. Navigate to your extracted files and open the Installer folder.

The contents of the Installer folder are displayed.
2. Right-click on the Kofax AP Agility installer and select Run as Administrator to begin the Setup

Wizard.
The installer opens and calculates if there is enough space on disk for the installation.

3. Click Next.
The Change, Repair, or Remove Installation window is displayed.

4. Click Repair.
Depending on how the ERP Connector Web Service is configured, an additional step may be
displayed before you can finalize the repair of your installation.

a. Optionally, if the ERP Connector Web Service users a Custom Account for the Pool Identity,
enter the Custom Account details and then click Next.

The Ready to Repair Kofax AP Agility 2.2.0 Setup Wizard step is displayed.
5. Click Repair.

A progress indicator shows the progress of the Kofax AP Agility installation.
6. Click Finish.

Optionally, select the View Installation Log option. This opens the log file once the installer is
closed.
The installer closes and if selected, the log file opens.
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Upgrade considerations

You can upgrade from an older version of Kofax AP Agility and Kofax Invoice Processing Agility to the
next released version of Kofax AP Agility, while maintaining the any customizations made. The Kofax AP
Agility and Kofax Invoice Processing Agility are implemented as sub-processes. These are automatically
upgraded to the new Kofax AP Agility package that is installed.

You must not modify any processes, business rules, or forms, with the exception of the following artifacts.
• Classification Group

• InvoiceProcessingAgility

• Document Group
• InvoiceProcessingAgility

• Forms
• CaptureDocument_Scan

• GeneralWorkQueue

• Invoices_Validation

• RescanRejectedDocs_Re Scan_Scan

• XMLDisplay

• IPA_SessionTimeout

• Processes
• CaptureDocument

• ParkNAIDocuments

• PostLinePairing

In most cases, changes to the project in Transformation Designer are required. This is because your
organization may have specific requirements that are not available in the out-of-the-box solution.

The following guidelines should be met when customizing your project. These guidelines ensure that any
customizations are still available in future versions of Kofax AP Agility.

Tip Keep notes about all changes made to a project. This is so that you can manually redo them if
necessary, or to confirm if a future upgrade and merge are successful.

It is important that you do not delete, move, or rename the following.
• Classes.
• Field Groups.
• Fields.
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• Locators.
If you delete one of these items and then add it back, the internal ID is no longer the same, so the item
does not behave as it should.

• All new Classes, Field Groups, Fields, or Locators should have a name that will not conflict with future
releases of the solution. For example, add the "Custom_" prefix to all new items.

• Do not remove any Databases, Dictionaries, Recognition Profiles, Table Models, or other dependent
settings.

• You can modify Recognition Profiles by adding an additional language.
• Add script below the marking line that says 'Modify script only below this line. Any

modifications above this line can cause problems with the package and are not included in a future
merge.

• In script, refer to lookup fields and other items by their name and not by their index IDs. This is because
the indexes can change and the names are not likely to change.

Note Document sets and training sets are included in the merge process. This means that if you have
documents in either the classification training set or the extraction straining set, make a copy of them
outside of the training folder to ensure that they are not lost during the merge. You can copy them back
after the merge.

Upgrade Kofax AP Agility
If you have an older version of Kofax AP Agility and Kofax Invoice Processing Agility installed already, it is
possible to upgrade these to the next released version of Kofax AP Agility by running the Kofax AP Agility
2.2.0 installer.

Important Ensure that Kofax TotalAgility is upgraded to the minimum version referenced in the Kofax
AP Agility Technical Specifications.

You can upgrade Kofax Invoice Processing Agility by following these steps.
1. Make a backup copy of your database before performing the upgrade.
2. Navigate to your extracted files and open the Installer folder.

The contents of the Installer folder are displayed.
3. Right-click on the Kofax AP Agility installer and select Run as Administrator to begin the Setup

Wizard.
The installer detects that there is an earlier version of Kofax AP Agility installed.

4. Right-click on the Kofax AP Agility installer and select Run as Administrator to begin the Setup
Wizard.
The installer opens and calculates if there is enough space on disk for the installation.

5. Click Next to upgrade Kofax AP Agility.
The installer opens and enables you to remove or change your Kofax AP Agility installation.

6. Select I accept the terms in the License Agreement and then click Next.
The Prerequisites Setup Wizard step is displayed along with any information about missing
prerequisites.
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7. The information displayed on the Prerequisites step is relevant if you are installing the listed
components only.
For example, if you receive a message that the SAP .NET connector is missing, but you are not
using SAP, ignore this message. However, if you are using one of the components listed, click
Cancel and then Finish to exit the Setup Wizard, install the required prerequisite, and then restart
the installer. Otherwise, click Next.
If you did not install the necessary prerequisites, the corresponding options are not available for
installation.
The Choose Setup Type Setup Wizard step is displayed.

8. Select one of the following installation methods.
• Click Full to upgrade all Kofax AP Agility features and install any features that are not already

installed.
Follow the Full installation steps to upgrade Kofax AP Agility using the Full method.

• Click Custom to upgrade selected Kofax AP Agility features. All previously installed features are
selected by default. You can choose additional features to install as necessary.
Follow the Custom installation steps to upgrade Kofax AP Agility using the Custom method.

9. To ensure that new jobs in the upgraded version of Kofax AP Agility work as expected, manually
refresh your address files before processing any invoices.

Important If you do not refresh you address files, all jobs are suspended and cannot be processed.
Refresh your address files and then restart any suspended jobs. These jobs are then processed as
normal.
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Remove Kofax AP Agility

If you no longer want Kofax AP Agility on your server, you can remove several components from your
server using the installer.

Specifically, the following components are removed.
• The Kofax AP Agility assemblies
• Agnostic ERP Web Service

There are some Kofax AP Agility components that are not removed using the installer. These include.
• The Kofax AP Agility database
• The Kofax TotalAgility package

You can remove the database manually by using the SQL Server Management Studio. However, Kofax
recommends that you do not remove the Kofax TotalAgility package. Leaving the package installed does
not affect Kofax TotalAgility performance.

Important Although it is also possible to remove Kofax AP Agility using Windows Programs and
Features, Kofax recommends that you use the Kofax AP Agility installer instead.

You can remove several Kofax AP Agility components by following these steps.
1. Double-click on the Kofax AP Agility installer.

The installer opens.
2. Click Next.

The Change, Repair, or Remove Installation step is displayed.
3. Click Remove.

The Ready to remove Kofax AP Agility 2.2.0 step is displayed.
4. Click Remove.

Several Kofax AP Agility components are removed and the completion step is displayed.
5. Optionally, select View Installation Log to see the log file.
6. Click Finish.

The installer closes and several Kofax AP Agility components are no longer installed on your server.
You can remove the remaining database manually.
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Access Kofax AP Agility documentation

By default, the Kofax AP Agility documentation is available online. However, if necessary, you can also
configure Kofax AP Agility to use help offline.

Default online documentation
The product documentation for Kofax AP Agility 2.2.0 is available at the following location.

https://docshield.kofax.com/Portal/Products/APAgility/2.2.0-2m13vo7ih4/APAgility.htm

To launch the online help for the Kofax AP Agility site, select the required help from the Help menu or click
on the Help button within the AP Agility Workflow.

Configure offline documentation
To access the documentation offline, download KofaxAPAgilityDocumentation-2.2.0_EN.zip from the
Kofax Fulfillment Site and extract it on a local drive available to your users.

This compressed file includes both help and print folders. The print folder contains all guides, such as
the Kofax AP Agility Installation Guide and the Kofax Analytics for AP Agility Administrator's Guide.

The compressed file for all other languages contains the help folder only. For more information on other
languages, refer to the Localized offline help

You can configure Kofax AP Agility to use offline help by following these steps.
1. Extract the contents of the compressed documentation file,

KofaxAPAgilityDocumentation-2.2.0_EN.zip.
2. Navigate to where Kofax TotalAgility is installed.

By default, this is <Program Files>\Kofax\TotalAgility.
3. In the Agility.Server.Web\Help\ folder, create a folder called en_US.

If you are using other languages, refer to the
4. Copy the help from the extracted EN zip file into the en_US folder.

Note This location is suggested because it is available and already used for Kofax TotalAgility
offline documentation. However, for Kofax AP Agility, it is possible to use any path for the help, as
long as it is on a web server available through http. Modify the paths below accordingly.

5. To configure the user help, open Kofax AP Agility with Administrative permissions.
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6. From the menu, select Settings > Administration.
The Administration page is displayed.

7. Locate the Help Base URL and make a note of its contents so that you can revert back to the online
help at any point in the future.

8. In the Help Base URL field, enter the following URL.
http://<Server>/TotalAgility/Help/.
Where <Server> is host name or IP address of the Kofax TotalAgility server.

9. Click Save Help Settings.
A message is displayed to indicate that your changes are saved successfully.

10. To test your changes, select any of Help menu options.
The help opens from the file-based location. If you selected to open the Configuration help, the path
should be similar to the following path.
http://<localhost>/TotalAgility/Help/en_US/CFG/
APAgility_Configuration_help/c_welcome.html.
If the help is not displayed, review your changes and try again.

Localized offline help
Localized help is available in German, Spanish, Brazilian Portuguese, and French for the following
activities. The language is indicated in the documentation zip file.

The following four activities are included in the localized help.

1. The invoice processing Scan activity

2. The invoice processing Validation activity

3. The invoice processing Line Pairing Correction activity

4. The AP Agility help, that consists of the following activities in a single help system.
• The AP Agility Workflow Coding activity.
• The AP Agility Workflow Approval activity.
• The AP Agility Workflow Hold activity.
• The AP Agility Workflow Comment Request activity.
• The AP Agility Workflow Exception activity.
• The AP Agility Workflow Line Pairing Exception activity.

For languages other than English, the zip file contains the help folder only. the print folder is available
for English only. Also, not all help is localized. Administrative help such as the Help for Kofax AP Agility
Settings and the Help for Kofax AP Agility PIX Correction are available in English only.

An example of the folder hierarchy needed to support multiple languages is as follows.
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Copy the required hierarchy using the above hierarchy as a reference. The country codes needed for the
supported languages are as follows.
• German - de_DE
• Spanish - es_ES
• French - fr_FR
• Portuguese (Brazilian) - pt_BR
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